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1. Welcome to COPA-DATA help

GENERAL HELP
If you cannot find any information you require in this help chapter or can think of anything that you

would like added, please send an email to documentation@copadata.com
(mailto:documentation@copadata.com).

PROJECT SUPPORT

You can receive support for any real project you may have from our Support Team, who you can contact
via email at support@copadata.com (mailto:support@copadata.com).

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email
sales@copadata.com (mailto:sales@copadata.com).

2. WPF element

With the WPF dynamic element, valid WPF/XAML files in zenon can be integrated and displayed.

¥ Information

All brand and product names in this documentation are trademarks or registered
trademarks of the respective title holder.


mailto:documentation@copadata.com
mailto:support@copadata.com
mailto:sales@copadata.com

3. Basics

XAML

XAML stands for Extensible Application Markup Language. The XML-based descriptive text developed
by Microsoft defines graphic elements, animations, transformations, displays of color gradients etc. in
Silverlight and WPF user interfaces. The use of XAML makes it possible to strictly separate design and
programming. The designer prepares, for example, the graphical user interface and creates basic
animations that are then used by the developers/project planners who create the application logic.

WPF
WPF stands for Windows Presentation Foundation and describes a graphics framework that is part of
the Windows .NET framework:

» WPF provides a comprehensive model for the programmer.

» XAML describes, based on XML, the interface hierarchy as a markup language. Depending on the
construction of the XAML file, there is the possibility to link properties, events and
transformations of WPF elements with variables and functions of
CD_PRODUCTNAME«<.

» The framework unites the different areas of presentation such as user interface, drawing,
graphics, audio, video, documents and typography.

For execution in zenon, Microsoft .NET framework version 3.5 or higher is required.

3.1 WPF in process visualization

XAML makes different design possibilities possible for zenon. Display elements and dynamic elements
can be adapted graphically regardless of the project planning. For example, laborious illustrations are
first created by designers and then imported into zenon as an XAML file and linked to the desired logic.
There are many possibilities for using this, for example:

DYNAMIC ELEMENTS IN ANALOG-LOOK

Graphics no longer need to be drawn in zenon, but can be imported directly as an XAML file. This makes
it possible to use complex, elaborately illustrated elements in process visualization. Reflections, shading,



3D effects etc. are supported as graphics. The elements that are adapted to the respective industry
environment make intuitive operation possible, along the lines of the operating elements of the
machine.

INTRICATE ILLUSTRATIONS FOR INTUITIVE OPERATION

The integration of XAML-based display elements improves the graphics of projects and makes it very
easy to display processes clearly. Elements optimized for usability make operation easier. A clear display
of data makes it easier to receive complex content. The flexible options for adapting individual elements
makes it easier to use for the operator. It is therefore possible for the project planners to determine
display values, scales and units on their own.

CLEAR PRESENTATION OF DATA AND SUMMARIES

Grouped display elements make it possible to clearly display the most important process data, so that
the equipment operator is always informed of the current process workflow. Graphical evaluations,
display values and sliders can be grouped into an element and make quick and uncomplicated control
possible.

INDUSTRY-SPECIFIC DISPLAYS

Elements such as thermometers, scales or bar graphs are part of the basic elements of process
visualization. It is possible, using XAML, to adapt these to the respective industry. Thus equipment
operators can find the established and usual elements that they already know from the machines in
process visualization at the terminal.

ADAPTATION TO CORPORATE DESIGN

&€&

Illustrations can be adapted to the respective style requirements of the company, in order to achieve a
consistent appearance through to the individual process screen. For example, the standard operation



elements from zenon can be used, which can then be adapted to color worlds, house fonts and
illustration styles of the corporate design.

3.2 Referenced assemblies

It is not just standard objects (rectangles, graphics, etc.) or effects (color gradients, animations, etc.) that
can be displayed using the WPF elements, but also customized user controls (with logic in the code
behind), which are referenced as assemblies.

For example, a user control that looks like a tacho and provides special properties and optical effects can
be created, such as a "Value" property, which causes the pointer of the tacho to move and/or the
corresponding value to be displayed in a label.

The workflow for this:
» The appearance of a user controls is labeled with standard objects, which are offered by WPF.
» The properties and interactions are programmed.

» The whole package is compiled and present in the form of a .NET assembly.

This assembly can also be used for WPF projects. To do this, it must be referenced (linked) in the WPF
editor (for example: Microsoft Expression Blend). To do this, select the assembly in the zenon file
selection dialog:

v \E DemoApplication

+ 1
=), Add Project Reference.. *

From this point in time, the WPF user controls of the assembly in the tool box can be selected under
Custom user controls and used in the WPF project.

v

See also, in relation to this, the following chapter: Guidelines for developers (on page 23).

USED REFERENCED ASSEMBLIES IN ZENON

To use an assembly in zenon, this must be provided as a file.
Collective files in .cdwpf format administer these independently; no further configuration is necessary.
Assemblies must be added to the Files folder for .xaml files:

» Clickon Files on the project tree

» Select Other

» Select Add file... in the context menu
» The configuration dialog opens

» Insert the desired assembly



When displaying a WPF file in the WPF element (Editor and Runtime), the assemblies from this folder
are loaded. It is thus also ensured that that when the Runtime files are transferred using Remote
Transport, all referenced assemblies are present on the target computer.

A collective file (.cdwpf) can exist alongside an XAML file with the same name. All assemblies (*.dll) from
all collective files and the Other folder are copied to the work folder. Only the highest file version is
used if there are several assemblies with the same name.

A Attention

Assemblies are only removed after loading when the application is ended. This means:

If a WPF file with a referenced assembly in zenon is displayed, then this assembly is
loaded is in the memory until zenon is ended, even if the screen is closed again. If you
would like to remove an assembly from the Files/Other folder, the Editor must first
be restarted, so that the assembly is removed.

MULTI-PROJECT ADMINISTRATION

With multi-project administration, the same assembly must be used in all projects. If an assembly is replaced
by another version in a project, it must also be replaced in all other projects that are loaded in the Editor or in
Runtime.

3.3 Workflows

The WPF/XAML technology makes new workflows in process visualization possible. The separation of
design and functionality ensures a clear distinction of roles between the project engineer and designers;
design tasks can be easily fulfilled by using pre-existing designs, which no longer need to be modified by
the project engineer.

The following people are involved in the workflow to create WPF elements in zenon:
» Designer
e llustrates elements
e takes care of the graphics for MS Expression Design
» MS Expression Blend operator
e Animates elements

e Creates variables for the animation of WPF elements in zenon, which project engineer can
access

» Project engineer
e Integrates elements into zenon:

e stores logic and functionality



We make a distinction:
» Workflow with Microsoft Expression Blend (on page 10)

» Workflow with Adobe lllustrator (on page 10)

33.1 Workflow with Microsoft Expression Blend

When using Microsoft Expression Blend, a WPF element is created in four stages:
1. lllustration of elements in MS Expression Blend (on page 11)
2. Open element in MS Expression Design and export as WPF
3. Animation in MS Expression Blend (on page 11)
4

Integration into zenon (on page 100)

You can find an example for creating a WPF elements with Microsoft Expression Blend in the Create
button as XAML file with Microsoft Expression Blend (on page 11) chapter.

3.3.2 Workflow with Adobe Illustrator

Based on traditional design processes with Adobe Illustrator the following workflow is available:
1. [lllustration of elements in Adobe lllustrator (on page 16)
2. Import of .ai files and preparation in MS Expression Design (on page 18)
3. WPF export from MS Expression Design (on page 18)
4. Animation in MS Expression Blend (on page 19)
5

Integration into zenon (on page 94)

You can find an example for creation in the Workflow with Adobe Illustrator (on page 15) chapter.

4. Guidelines for designers

This section informs you how to correctly create WPF files in Microsoft Expression Blend and Adobe
Illustrator. The tutorials on Creating a button element (on page 11) and a bar graph element (on page
15) show you how fully functional WPF files for zenon can be created from pre-existing graphics in a few
steps.
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The following tools were used for this:
» Adobe lllustrator CS3 (Al)
» Microsoft Expression Design 4 (ED)
» Microsoft Expression Blend 4 (EB)

» zenon

¥ Information

If referenced objects (assemblies) are used in WPF, note the instructions in the
Referenced objects (on page 8) chapter.

4.1 Workflow with Microsoft Expression Blend

With Microsoft Expression Blend, a WPF element:
» isillustrated
» is converted into WPF format using MS Expression Design

» animated

The following example shows the illustration and conversion of a button element into an XAML file.

Note: A test version of "Microsoft Expression Blend" can be downloaded from the Microsoft website.

4.1.1  Create button as an XAML file with Microsoft Expression Blend

CREATE BUTTON

1. Start Expression Blend

11



2.

select the New Project option

r

Projects

ﬁ New Project...
E Open Project...

V! Run at startup Close

S

Select WPF as project type

give it a path and name of your choice (MyBlendProject, for example)

gé WPF Application

ff§ wer control Library

'PF Databound Application

A project for creating custom controls that can be reused across
other WPF applications.

MName
Location endProject!, Browse...
Language

Version

Cancel

The Language and Version settings can be ignored, because no functionality is to be
programmed.

After the dialog has been confirmed with OK, Microsoft Blend creates a new project with the

chosen settings. Expression Blend adds an empty XAML file which already contains a class
reference.

Delete the CS file that belongs to the XAML file using the context menu.

12



7. Rename the XAML file MainControl.xaml to MyButton.xaml.

8. The development size of the file is set at 640 x 480 pixels as standard and must still be changed:
a) switch to XAML view
b) correct the size to 100 x 100 pixels

c) Delete the class reference x:Class="MyBlendProject.MyButton"

MyButton.xaml =

1 <UserControl

2 wmlns="http://schemas.microsoft. com/winfx/2806/xaml/presentation”

3 xmlns:x="http://schemas.microsoft.com/winfx/2066/xaml"”

4 xmlns:d="http://schemas.microsoft.com/expression/blend/2668"

5 xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
6 mc:Ignorable="d"

7 »:Name="UserControl” )

3 d:DesignwWidth="108" d:DesignHeight="J£!*U

18 <@Grid x:Name="LayocutRoot" />

12 < /UserControl:

9. switch to Design view

10. add a button via the toolbar
11. define the properties

e Width: 50

e Height: 50

13



e Margins: 25

v Layout
Width 50
Height 50
Row 0 RowSpan 1
Column 0 ColumnSpan 1

Zindex 0

HorizontalAlignment  |[= =

VerticalAlignment [T - In
Margin + 25

t+ 25

12. Save the changes and open the file in Internet Explorer to check it. You will see that the button is
displayed in a size of 50 x 50 pixels.

MAKE BUTTON SCALABLE
If you integrate this status into zenon, the button will always have the exact size of 50 x 50 pixels.
Because the button can be implemented as a scalable button, switch to Expression Blend again:
1. select the button in the tree view
2. select the Group Into->Viewbox button in the context menu
3. the button is inserted into a Viewbox
4. Define the properties of the viewbox
e  Width: Auto
e Height: Auto

14



5. save the file

Cut
Copy
Paste
Delete

Rename

Order 3
Align 3
3

Auto Size

Group Into 3 Grid

StackPanel
PFin Active Container DockPanel

SIEEE ZTE I Data bind Content to Data... Canvas

Edit Text ScrollViewer

Bord
UserControl Make Into Control... arder

WrapPanel
Make Into UserControl... rapFane

UniformGrid

Edit Additional Templates 3
youtRoot

) [Button] "Button™

6. If you now open the file in Internet Explorer, the button is automatically scaled when the IE
window size is changed. This file will now also automatically adapt to changes in the size of the
WPF element in zenon.

CHANGE NAME

Before you can integrate the file into zenon, you must give the WPF element a name. The WPF elements
are not named in Expression Blend as standard, and are labeled with square brackets and their type.
zenon content is assigned to WPF content via the name of the WPF elements:

» intree view, change the name
e of the button on MyButton

o of the ViewBox to MyViewBox

This button can now be integrated in zenon (on page 100) as an XAML file.

4.2 Workflow with Adobe lllustrator

When Adobe lllustrator is used, a WPF element:
» isillustrated in Adobe Illustrator
» isconverted into a WPF in MS Expression Design

» isanimated in MS Expression Blend

The following example shows the illustration and conversion of a bar graph element into an XAML file.

15



4.2.1  Bar graphillustration

A bar graph is created in Adobe Illustrator.

1. Al: Starting element for bar graph

Illustrated in Adobe Illustrator CS3.

2. Al Path view of bar graph in Adobe lllustrator

-
-

All effects must be converted (Object -> Convert appearance)

All lines are transformed into paths (Object -> Path -> Contour line)

Do not use filters such as shading, blurring etc.

NOTES ON COMPATIBILITY

Illustrations that were created with Adobe Illustrator are in principle suitable for WPF export. However,
not all lllustrator effects can become corresponding effects in Expression Design/Blend. Note:

16



Effect

Clipping masks

Filters and effects

Text fields

Transparencies and group
transparencies

Multiply levels

Indicating instruments and
standard positions

Description

Clipping masks created in Adobe Illustrator are not correctly interpreted
by Expression Design. These are usually shown in Blend as areas of black
color.

We recommend creating illustrations without clipping masks.

Not all Adobe Illustrator filters are transferred into Expression Design
accordingly:  Thus blurring filters, shading filters and corner effects from
Illustrator do not work in Expression Design.

Solution:

> Most effects can be converted so that they can be read correctly by
Expression Design using the Object -> Convert appearance
command in Adobe Illustrator.

» Corner effects from Adobe lllustrator are correctly interpreted by MS
Design if they are converted to Al in paths.

To be able to link text fields with code, these must be created separately
in Expression Blend. "Labels" are required for dynamic texts; simple
"text fields" are sufficient for static information.

There is no possibility to create text labels in MS Design. These must be
directly created in MS Blend.

There can be difficulties in Adobe lllustrator with the correct
interpretation of transparency settings, in particular from group
transparency settings.

However MS Expression Blend and MS Expression Design do offer the
possibility to create new transparency settings.

These level settings in Adobe lllustrator are not always correctly
displayed by MS Expression Blend.

However, there is the possibility to "Multiply levels" directly in
Expression Design.

To prepare the graphics optimally for animation, the indicator and slider
must always be set to the starting position, usually 0 or 12:00
o'clock.

Thus the position parameters for rotations etc. are also correct in Blend
and an animation can be implemented without conversion of position
data.

17



4.2.2  WPF export

WPF files are required for animation in Microsoft Expression Blend. We recommend Microsoft
Expression Design for this export, because it provides good results and most lllustrator effects are
correctly interpreted.

Note: There is a free plug-in for the direct export of WPF files from Adobe Illustrator available on the
internet. This plug-in provides a quick, uncomplicated way of exporting from lllustrator, however it is
less suited to the current application because it lead to graphical losses. Even color deviations from the
original document are possible.

Files in .ai format can regularly be imported into Expression Design; the paths are retained in the
process.

Attention: Some common Illustrator effects cannot be displayed by Expression Design correctly
however (see lllustration (on page 16) chapter).

We export the pre-created bar graph element in 5 stages:

1. ED:Import

e Import the prepared lllustrator file (on page 16) in Microsoft Expression Design via File ->
Import

2. ED: Optimization

e If the starting file is not correctly displayed in MS Expression Design, it can still be
subsequently edited and optimized here

18



4.

4.2.3

>

>

ED: Select

e Highlight the element for WPF export with the direct selection arrow in MS Expression
Design; in this case it is the whole clock

ED: Start export

e  Start the export via File -> Export
e the dialog for configuring the export settings opens

ED: Export settings

e Enter the following export settings:
a) Format: XAML Silverlight 4 / WPF Canvas

Always name objects: Activate with tick

Place the grouped object in an XAML layout container: Activate with tick
b) Text: Editable text block

c) Lineeffects: Rasterize all

The exported file has .xaml file suffix. It is prepared and animated (on page 19) in MS Expression Blend
in the next stage.

Animation in Blend

With MS Expression Blend:

static XAML files from MS Expression Design are animated

Variables for controlling effects that can be addressed by zenon are created

19



In thirteen steps, we go from a static XAML to an animated element, that can be embedded in zenon:

1. EB:create project

a) Open Microsoft Expression Blend

b) Create a new project

c) Select the Project type of WPF- >WPF Control Library
d) Give it a name (in our tutorial: My_Project)

e) Select a location where it is to be saved

f) Select a language (in our tutorial: C#)

g) Select Framework Version 3.5

2. EB:delete MainControl.xaml.cs

a) Navigate to MainControl.xaml.cs

b) Delete this file using the Delete command in the context menu

3. EB: Open exported XAML file
B

a) Open the context menu for My_Project (right mouse button)
b) Select Add existing element...

c) Select the XAML file exported from Microsoft Expression Design, in order to open this in
Microsoft Expression Blend

4. EB: Open MainControl.xaml

20



a) Open the automatically created MainControl.xaml
b) Inthe Objects and Time axes area, navigate to the UserControl entry

EB: Adapt XAML code

a) Click on UserControl with the right mouse button
b) Select Display XAML in the contextual menu.
c) Delete lines 7 and 9 in the XAML code:

x:Class="My_ Project.MainControl"

d:DesignWidth="640" d:DesignHeight="480"

EB: check XAML code

e The XAML code should now look like this:
<UserControl

xmlns=http://schemas.microsoft.com/winfx/2006/xaml/presentation
xmlns:x=http://schemas.microsoft.com/winfx/2006/xaml
xmlns:d=http://schemas.microsoft.com/expression/blend/2008
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2006"

mc:Ignorable="d"
x:Name="UserControl">

<Grid x:Name="LayoutRoot"/>

</UserControl>

EB: Copy elements

a) Open the XAML file imported from Expression Design
b) Mark all elements
c) Select Delete in the context menu

d) Change back to the automatically created XAML file

21



10.

11.

12.

EB: Insert element

a) Click on Layout Root with the right mouse button
b) Select Insert

EB: Adapt layout type

a) Click on Layout root -> Change layout type -> Viewbox with the right mouse button
b) The structure should now look like this: UserControl -> LayoutRoot -> Grid -> Elements
c) Give a name for LayoutRoot and Grid by double-clicking on the names

EB: Texts and values

e Dynamic and static texts are labeled with text fields

Values (humbers) are issued with Labels

EB: Insert labels

e Labels replace numbers that are to be subsequently linked using INT variables (must be
carried out for all number elements)

EB: Set property

e Todisplay 100%, set the bar graph element's MaxHeight property to 341 (the maximum
height of the indicator element is 340)

22



13. EB: prepare for use in zenon

a) Delete all name labels (names may only be given for elements that are to be addressed via
zenon)

b) Save the XAML file with any desired name
c) Integrate the XAML file into zenon (on page 94)

A tip for checking: If the XAML file is displayed with no problems in Microsoft Internet Explorer and
the window size of Internet Explorer adapts to it, it will also be correctly used in zenon.

5. Guidelines for developers

This section handles the creation of simple WPF user controls with code-behind functionality using
Microsoft Visual Studio and debugging this user control in Runtime.

The following tools were used for this:
» Microsoft Visual Studio 2015

» zenon

¥ Information

A Microsoft Visual Studio version from 2012 is recommended, due to the
better-integrated XAML designer.

5.1 Creation of a simple WPF user control with code behind
function

The creation and incorporation of a simple user control is described in this chapter. Because only the
fundamental mechanisms/process for integration into zenon is described, the functionality of the user
control is limited to the addition of two values. There is intentionally no enhanced error handling or
explicit completion, in order to retain the simplicity of this example.
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CREATE WPF USER CONTROL

1.

Create a new Solution and a WPF User Control Library in this in Visual Studio.

The .NET framework version 4 was selected for this example. A different version can also be
selected, which must be installed on the target system on which Runtime will subsequently be
started.

Info: If the corresponding project template does not appear in the list of available templates,
this can be added by means of the search (field at the top right of the dialog).

MNew Project
P Recent .MET Framework 4.5 - Sort by: Default - 55 5= wpf user X -
4 |nstalled . .
g WPF User Control Library Visual C# Type: Visual C=
-
4 Templates Windows Presentation Foundation user
. . VB -
4 Visual C# .‘i WPF User Control Library Visual Basic control library
4 Windows At
Universal
B Windows 8
Classic Desktop

Web

Android

Cloud

Extensibility

i0s

LightSwitch

Office/SharePoint

Silverlight

Tact -
P Online
Name: WPFUserControlLibrary
Location: [:h\sources -
Solution name: WPFUserControlLibrary Create directory for solution

[] Add to source control
| oK | | Cancel

In our example, the project is given the name WPFUserControlLibrary.
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2. Create 3 text boxes and a button in the UserControll.xaml file:

L ]
Enter 3 value ¢
Enter a value
] =1
Add Values
Result
i 2 L

(38 HIE- ol P I
o BXAaML

<UserControl x:Class="WPFUserContrelLibrary.UserControll”
xmlns="http://schemas.microsoft.com/winfx/2066/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
xmlns:mc="http://schemas.cpenxmlformats.org/markup-compatibility/2ee6"

="http://schemas.microsoft.com/expression/blend/2888"

ocal="clr-namespace:WPFUserControlLibrary”

xmlns
xmlns
mc:Ignorable="d"
d:DesignHeight="126" d:DesignWidth="3@8">
<Grid Height="12@" width="Auto™>
<StackPanel>
<TextBox x:Name="textBoxA" Height="30" TextWrapping="Wrap" Text="Enter a value™ HorizontalAlignment="Stretch"/>
<TextBox x:Name="textBoxB" Height="38" TextWrapping="Wrap" Text="Enter a value"” HorizontalAlignment="Stretch"/>
<Button x:Name="buttonAdd” Height="38" Content="Add Vvalues"” HorizontalAlignment="Stretch” VerticalAlignment="Top" Click="buttonAdd Click"/»
<TextBox x:MName="textBox(C" Height="38" TextWrapping="Wrap" Text="Result" HorizentalAlignment="5tretch" IsReadOnly="True"/>
</stackPanel>
</Grid>
</UserControl>

3. Add the following code in the click event of the button:
private void buttonAdd_Click(ohbject sender, Routedfventirgs e)
¢ try
} textBoxC.Text = (Convert.ToInt32(textBoxA.Text) + Convert.ToInt32(textBoxB.Text)).ToString();

catch (Exception ex)

textBoxC.Text = “Error adding values: " + ex.Message;

}
}

Now you have the user control with the required functionality available. However, because zenon can
only display XAML files that do not link to a code-behind file, an additional XAML file is needed that
references the library (assembly) that has just been built.

CREATION OF THE XAML FILE (WITHOUT CODE BEHIND) FOR ZENON

Proceed as follows to create the XAML file required in zenon.
1. Create a further project, again as a WPF User Control Library

2. It was called WPFUserControlNoCodeBehind in our example.
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3. Insert a reference to the project that has just been built into this new project.

Reference Manager - WPFUserControlNoCodeBehind

b Assemblies Search Projects (Ctrl+E) P~
4 Projects Mame Path Name:
Solution | % WPFUserControllibrary  Di\sources\WPFUserCo WPFUserControlLibrary

P Shared Projects
b COM

P Browse

4 »

Browse... || OK || Cancel

4. The XAML files (UserControl1.xaml) looks as follows:

<UserControl x:Class="WPFUserControlNoCodeBehind.UserControll™
xmlns="http://schemas.microsoft.com/winfx/2806/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2086/xaml"”
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
xmlns:d="http://schemas.microsoft.com/expression/blend/2668"
xmlns:local="clr-namespace:WPFUserControlNoCodeBehind™
mc:Ignorable="d"
d:DesignHeight="3@8@" d:DesignWidth="308">

<Grid>

</farid>
</UserControl>

5. Because all necessary content is contained in the DLL that has been created and no code-behind
file can be used, delete the following lines:
x:Class="WPFUserControlNoCodeBehind.UserControll"
xmlns:local="clr-namespace : WPFUserControlNoCodeBehind"

6. Also delete (for the designer's size setting) the following lines:
mc:lgnorable="d"
d:DesignHeight="300" d:DesignWidth="300"

7. Delete the code-behind file (UserControl1.xaml.cs) in this project.

8. Drag the user control that has been created beforehand (for the project
WPFUserControlLibrary) over the toolbox in the XAML designer.

9. Assign a name for the grid and the user control.

Attention: If no name is given here, these elements do not appear in the linking dialog in the
zenon Editor and thus cannot be made dynamic.
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10. The XAML file should now look as follows:

0.
Enter & value
1
Enter a value
€
Add Values

Result
n

S oEE - B4
o ExaML
<UserControl xmlns="http://schemas.microsoft.com/winfx/20@6/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2066/xaml"”
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
xmlns:d="http://schemas.microsoft.com/expression/blend/2668"
xmlns:WPFUserControllibrary="clr-namespace:WPFUserControllibrary;assembly=WPFUserControllibrary™>
<Grid Name="MainGrid"»
<WPFUserControllibrary:UserControll Name="AdditionControl™ HorizontalAlignment="Left" VerticalAlignment="Top"/>
</Grid>
</UserControl>

In the next step, how the DLL and XAML file are incorporated into zenon is explained.

STEPS IN ZENON

1. Open the zenon Editor
2. GotoFile -> Graphics.

3. Select Add file... in the context menu

!-; User administration
T" SAP intedace
) Files =
2] G = 1
& L2l Add file...
Y
E :: Folder new...
) Te R : folder.
= C
o O
I\ History Editor profile 3
v Proect
sbal symbol il Help - |
7] ¥ j

tree _QEEL Network topology

4. Select the XAML file at the save location (UserControl1.xaml from the
WPFUserControlNoCodeBehind project) and add this:

FEMNECE R —RNEETE W S T M )

Status File name | Type Size Preview
r r r r r
UserControll xaml xaml 0KB

5. Insert the DLL with the functionality for the XAML file.
To do this:

a) Select, in the context menu, File -> OtherAdd file....



b) Select the file WPFUserControlLibrary.dll (from the output path) of the first project
(WPFUserControlLibrary).

s B E BaAaXx B L9 59
State| File name # | Type Size
WPFUserControlLibrary.dll dil GKB

6. Createa zenon screen.
7. Add a WPF element and select the previously-incorporated XAML file.

You should now see the following in the zenon Editor:

LD By 53 3¢ | BE -
State| Name i Sereen

Enter a value

Screen 0 Standa
Enter a value

‘ Add Values ‘

Result

8. Start zenon Runtime in order to also test the control there.

10

20

Add Values

30

¥ Information

The XAML file and referenced assemblies can also be saved in complied form as a

* cdwpf file. Only one file thus need to be imported in the Editor (under Files ->
Graphics). Further information on this can be found in the CDWPF files (collective
files) (on page 47) chapter.

Hint: When developing a WPF user control, it is usually more practical to insert the
XAMIL file and the referenced DLL(s) separately. This makes the replacement of the
DLL and debugging easier. Further information on the topic of debugging in the
Debugging the WPF user control in Runtime (on page 29).
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A Attention

Assemblies are only removed after loading when the application is ended. This means:

If a WPF file with a referenced assembly in zenon is displayed, then this assembly is
loaded is in the memory until zenon is ended, even if the screen is closed again. If you
would like to remove an assembly from the Files/Other folder, the Editor must first
be restarted, so that the assembly is removed.

Further examples can be found in the Examples: Integration of WPF into zenon (on page 94) chapter.

5.2 Debugging the WPF user control in Runtime

To debug the WPF user control in Runtime, proceed as follows.

In this example, the control described in the Creation of a simple WPF user controls with code behind
function (on page 23) is used.

DEBUGGING BY MEANS OF ATTACH TO PROCESS

1. Ensure that zenon Runtime has been started and a screen with the WPF user control is open.

Furthermore, ensure that the DLL that is currently being used corresponds to the build (Version)
of the user control project (WPFUserControlLibrary).

2. Set a breakpoint in the click event of the button in the Visual Studio project

28 = private void buttonAdd_Click(cbject sender, RoutedEventirgs e)
29 {
EL try
31 {
[ 32 extBoxC.Text = (Convert.ToInt32(textBoxA.Text) + Convert.ToInt32(textBoxB.Text)).ToString();
33
34 catch (Exception ex)
35 {
36 textBoxC.Text = “Error adding values: " + ex.Message;
37 }
38 }

3. In Visual Studio, under Debug , select the Attach to Process menu item.
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Select the zenon Runtime process

Attach to Process

Transport: Default

Qualifier; -

Transport Information
The default transport lets you select processes on this computer or a remote computer running the Visual Studio Remote Debugger
(MSVSMON.EXE).

Attach to: Automatic: Managed (v4.6, v4.5, v4.0) code

MAyailable Processzes

Find...

Select...

Process [[o] Title Type

ZenSysSrv.exe 4680 x64

Zenrt32.exe zenon Energy Edition Managed (v4.0.30319), Managed (v2.0.50727), x86

ZEMOME32. exe 8532 zenon Energy Edition Managed (v4.0.30319), Managed (v2.0.50727), x86

zenon_startup.exe 7048 x26

zenDB5rv.exe 17256 xb4

XDesProc.exe 14528 Managed (v4.0.30319), x86

XDesProc.exe 4a92 Managed (v4.0.30319), x86

XDesProc.exe B6TE Managed (v4.0.30319), x86

WhkSvMgr.exe 11080 x26

WIRNAIMEN EYE S10R T

£ >
[ Show processes from all users Refresh

Under Attach to, select either Automatic or the corresponding .NET framework version (v4.x in
this case)

(®)Automatically determine the type of code to debug:

() Debug these code types:

GPU - Software Emulator ~
Managed (CoreCLR)

Managed (v3.5, v3.0, v2.0)

Managed (v4.6, v4.3, v4.0)

Native

Script A

Click on Attach.
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7. Now trigger the breakpoint in which you enter values into the WPF control in zenon Runtime and
click on the button

28 = private void buttonAdd_Click(cbject sender, RoutedEventirgs e)
29 {
1 EL try
20 31
Qo 32 fextBoxC.Text = (Convert.ToInt32(textBoxA.Text) + Convert.Tolnt3:
33 } | & textBoxC.Text| Q ~ "30" = |
wEalEls 34 catch (Exception ex)
30 35
36 textBoxC.Text = "Error adding values: " + ex.Message;
100 % o
Autos Locals Watch1 + X Find Symbol Results Find Results Call Stack
Mame Value
& textBoxA Text "0
K& textBoxB. Text 20"

DEBUG USING START EXTERNAL PROGRAM

1. Ensure that zenon Runtime has been closed.

2. Ensure that, in the zenon Editor, the project that contains the WPF user control has been set as
the start project.

3. Ensure that the user control project (WPFUserControlLibrary) is set as the start project in Visual
Studio.

fa] Solution "WPFUserControlLibrary' (2 projects)

4 NPFUserControllibran
b | & Buid
4 Rebuild
“ Clean

4 View 3
3 Analyze 3
4 Scope to This

MNew Selution Explorer View

Bl Ely

Show on Code Map

Build Dependencies 3
Add 3
Manage NuGet Packages...

Start Memory Profiler

Debug with Mermaory Profiler

Set as StartUp Project

S E =

4. Inthe project properties of the Visual Studio project, select under Debug, for Start action: Start
external program

5. For Start external program, select the path of the zenon Runtime application.

6. Under Working Directory, select the \wpfcache folder of the Runtime files
(...\PROJECTNAME\RT\FILES\zenon\custom\wpfcache)
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10.
11.

Hint: In the selected project in the zenon Editor, press the keyboard combination CTRL+ALT+R
in order to jump directly to the root directory of the Runtime files.

Build Events Start Action
Debug*®
O Stat projec
Resources
(® Start external program: |0 Files (x86)\COPA-DATA\zenon 7.50 SPONZenrt32.exe

Services
Settings (O Start browser with URL:
Reference Paths Start Options
Signin

2 Command line arguments:
Code Analysis

Working directory: [R\TESTPROJECT\RT\FILES\zenon\custom\wpfcache|

In the project properties, enter \wpfache folder of the Runtime files as the output path under
Build

Output

Output path: |ER\TESTP ROJECT\RT\FILES\zenon' custom'wpfcache Browse...

Create the project in Visual Studio
Start debugging in Visual Studio with Start

b Start - |
I

zenon Runtime is now started automatically.

Trigger the breakpoint by entering values in the WPF control in zenon Runtime and click on the
button

28 = private void buttonAdd_Click(cbject sender, RoutedEventirgs e)
29 {
1 EL try
20 31
Qo 32 fextBoxC.Text = (Convert.ToInt32(textBoxA.Text) + Convert.Tolnt3:
33 ¥ | & textBoxC.Text| Q ~ "30" = |
wEalEls 34 catch (Exception ex)
30 35 {
36 textBoxC.Text = "Error adding values: " + ex.Message;
100 % o
Autos Locals Watch1 + X Find Symbol Results Find Results Call Stack
Mame Value
& textBoxA Text "0
K& textBoxB. Text 20"
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¥ Information

When starting zenon Runtime, the assemblies (DLLs) referenced in the WPF user
controls from the \FILES\zenon\custom\additional folder, and/or the assemblies
from CDWPF files in the \FILES\zenon\custom\wpfcache folder are copied. If the file
version of the DLL in the \wpfache folder is one higher than the version of the
"original file", it is not replaced!

For debugging, it is thus sufficient to only replace the file that is on the \wpfache
folder directly.

For delivery, it must be ensured that the current version of the DLL is present in the
\additonal folder or the CDWPF file!

Attention: If only the DLL is updated in the \additional folder or in the CDWPF, but
the version number is not increased, the DLL must be deleted manually in the
\wpcache folder, because it is not updated otherwise (due to the above-described
mechanism).

A Attention

Assemblies are only removed after loading when the application is ended. This means:

If a WPF file with a referenced assembly in zenon is displayed, then this assembly is
loaded is in the memory until zenon is ended, even if the screen is closed again. If you
would like to remove an assembly from the Files/Other folder, the Editor must first
be restarted, so that the assembly is removed.

5.3 Data exchange between zenon and WPF user controls

There are different possibilities for exchanging data between zenon and WPF user controls.
» Data exchange using dependency properties (on page 34)

» Data replacement via VSTA (on page 37)
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5.3.1 Data exchange using dependency properties

The most elegant and secure way to exchange data between zenon and self-created WPF user controls
is by using dependency properties.

The WPF user control project created in the Creating a simple WPF user controls with code behind
function (on page 23) serves as a basis (WPFUserControlLibrary).

In this chapter too, the focus is purely on the core theme (dependency properties and data exchange
between the user control and zenon in this case). Specific WPF features such as data connection, etc., as
well as explicit error handling, are not covered.

ADDITIONS TO THE CODE

1. Create the TextChanged Event for the textBoxa element in the UserControl1.xaml file
TextChanged="textBoxA TextChanged"
2. Add the following lines of code in the usercontroll class of the code behind file
(UserControl1.xaml.cs)
/// <summary>
/// Gets or sets the ValueA.
/// </summary>
public double ValueA
{
get
{

return (double)GetValue (ValueADependencyProperty) ;
set

SetValue (ValueADependencyProperty, wvalue);

/// <summary>

/// Dependency property for ValueA

/// </summary>

public static readonly DependencyProperty ValueADependencyProperty =
DependencyProperty.Register ("ValueA", typeof (double),

typeof (UserControll), new FrameworkPropertyMetadata (0.0, new
PropertyChangedCallback (OnValueADependencyPropertyChanged))) ;
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/// <summary>

/// Called when [value a dependency property changed].
/// </summary>

/// <param name="source">The source.</param>

/// <param name="e">The <see cref="DependencyPropertyChangedEventArgs"/> instance
containing the event data.</param>
private static void OnValueADependencyPropertyChanged (DependencyObject source,

DependencyPropertyChangedEventArgs e)
{

UserControll control = source as UserControll;
if (control != null)
{
try
{
control.ValueA = (double)e.NewValue;
control.textBoxA.Text = control.ValueA.ToString();

}

catch (Exception)

{}

/// <summary>
/// Handles the TextChanged event of the textBoxA control.
/// </summary>
/// <param name="sender">The source of the event.</param>

/// <param name="e">The <see cref="TextChangedEventArgs"/> instance containing the

event data.</param>
private void textBoxA TextChanged(object sender, TextChangedEventArgs e)
{
try
{
ValueA = Convert.ToDouble (textBoxA.Text) ;
}
catch (Exception)

{}
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Then build the solution.

Information

A numerical property (double) is used in this example. Other simple data types (such
as bool, string, int, etc.) can also be used.

LINKING IN ZENON

1.

Update the WPF user control (DLL) in the zenon Editor.

To do this, proceed as described in the Creating a simple WPF user controls with code behind
function (on page 23) and note that, under certain circumstances, the zenon Editor must be
restarted if another version of the assembly (DLL) has been loaded by the Editor.

Create a numeric variable in zenon and link it to a dynamic text element in the screen next to the
WPF element with your user control.

Open the screen that contains the WPF element and select, for the WPF element, under WPF
links: Configuration

f 3 R tati
{2 Representation WPF links

Ll Effects
= Configuration: Click here -»

-2 Visibility/flashing
-{7) General
i) Position
i) Runtime

-2 Autherization
“{C3) WPF links

Expand the node in the tree at the top left and select AdditionControl

WPF element

WPF element
Available elements Preview

=I- MainGrid
- AdditionControl

Enter a value

Enter a value

Add Values

Result

Action link

Properties Events | Transformations

Linked | MName Linkage # Type of link | WPF info ~

[] Values myZenonVariableA Variable 0 1
] Content <MNaothing lin... | System.Windows.Con...
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5. Select the line with valuen (this is the name of the property that was created in the code
beforehand) and select, for Type of link:, Variable.

Hint: Give Properties a prefix so that this can be found more easily, for example: valuer

6. Inthe column under Linkage, print out the variable that was created in zenon beforehand

Link variable

OK
Linked variable
myZenonVariableA m Cancel

Range of values of the WPF element Help
[ convert range of values

Minimum Maximum
a a

7. Confirm the dialog with OK and build the Runtime files

8. Start Runtime in order to test the WPF user control

10 10

Enter a value

‘ Add Values ‘

Result

9. If the value is changed in user control, the value automatically changes in zenon and vice versa.

10. Of course you can debug the control as described in the Debugging the WPF user control in
Runtime (on page 29) chapter, as well as create further dependency properties.

Y Information
The UserControl Loaded event can be used in order to (automatically) access the

values of the dependency property during initialization (when calling up the user control)
for example.

5.3.2 Data replacement via VSTA

Data can also be exchanged between zenon and WPF user controls using VSTA.

The APl element methods
» get WPFProperty (reading of values)

» set WPFProperty (writing of values)
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are used for this.

The example used here is based on the example used in the Data exchange using dependency properties
(on page 34) chapter.

CREATION OF A VSTA MACRO FOR DATA EXCHANGE BETWEEN ZENON AND THE WPF
USER CONTROL

1. Create the following VSTA macro in the project add-in of the zenon project

Sample Macro for data exchange between V5TA and a WPF User Control
public W
{

//Get the Screen and Element hosting the WPF User Control
P ure myWPFScreen = this.DynPictures().Item("Screen");
nt myWPFElement = myWPFScreen.Elements().Item("WFF _Element");

d MacroWPFhccess ()

zenOn.

//Read the current value from the WPF Element property
doukle currentValue = Convert.ToDouble (myWPFElement.get WPFProperty ("AdditionControl®™, "Valueld"));

//Double the walue and write it back to the WPF Element property
myWPFElement.set WPFProperty ("ARdditionControl", "ValueRA", currentValue * 2);

Whereby:

e "Screen" is the name of the zenon screen in which the WPF element is located

e "WPF_Element" is the name of the WPF element that contains the WPF user control

e "AdditionControl" is the name of the WPF user controls itself (defined in the
(UserControl1.xaml file)

e "valuea" is the name of the user control property

2. Create an execute VSTA macro function and link this to a button in the screen in which the WPF
element is also located

3. Start Runtime to test changes

64 l Read and double value

Enter a value

Add Values ‘

Result
When executing the macro, the value is read by the control, doubled and written back.

Y Information

The user control properties used for this method of data exchange need not necessarily
be dependency properties, as outlined in this example. "Standard" properties can also be
used, see in relation to this the Access via VSTA "variable link" (on page 39) chapter.
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5.4 Access to the zenon (Runtime) object model from a WPF user
control

There are different possibilities for access to the zenon object model from a WPF user control. This is
explained in more detail in the following chapters.

5.4.1 Access via VSTA "variable link"

In order to get access to the zenon Runtime COM interface by means of "variable link", proceed as
follows. The creation of a simple WPF user controls with code behind function (on page 23) serves as an
initial example.

Y Information
The following code is intended to show an example of how the COM implements

access to zenon Runtime and in doing so limits itself to the basic functionality. There
is no explicit error handling, etc.

NECESSARY AMENDMENTS IN WPF USER CONTROL

The following steps are necessary in the WPF user control project (WPFUserControlLibrary).

Firstly, a reference to the zenon COM interface must be incorporated.

a1 Solution "WPFUserControlLibrary' (2 projects)
4 WPFUserControllibrary
b Properties

4 Of] References

Reference Manager - WPFUserControlLibrary

P Assemblies

b Projects MName Version

b Shared Projects WPDSp 1.0 Type L.ibrar)r 1.0

wschAPl 1.0 Type Library 1.0

4 COM Wscui.cpl 1.0 Type Library 1.0

WSHControllerLibrary 1.0

WUAPI 2.0 Type Library 20

Recent K5Editor ActiveX Control module 1.0

X5Manitoring ActiveX Control module 1.0

b Erowse XP5_SHL_DLL 1.0 Type Librar}r 1.0

XP5_SHL_DLL 1.0 Type Library 1.0

zenDB5rv 3.0 Type Library 3.0

zenMetSrv 3.0 Type Library 3.0

zenon programming interface library 1.0

After this, the following code must be inserted in the Usercontroll class:
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//The zenon Project

zenOn.Project zenonProject = null;

/// <summary>

/// Property for the Variable link via VSTA

/// </summary>

public object zenonVariableLink

{

get { return null; }
set
{
if (value != null && zenonProject == null)

{

zenOn.Variable zenonVariable;
try
{
zenonVariable = (zenOn.Variable)wvalue;
}
catch (Exception)

{

return;
}
if ((zenonVariable!= null) && (!string.IsNullOrEmpty(zenonVariable.Name)))
{

zenonProject = zenonVariable.Parent.Parent;

/// <summary>

/// Trigger used to notify the control from VSTA to release the COM resources

/// </summary>

public object zenonReleaseTrigger

{

get

set

{ return null; }
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if ((bool)wvalue && zenonProject != null)
{
try
{
Marshal.FinalReleaseComObject (zenonProject) ;
}
catch (Exception)
{
return;

}

zenonProject = null;
GC.Collect ()
GC.WaitForPendingFinalizers() ;

GC.Collect ();

Whereby access to the properties zenonvariableLink (to initialize the COM object) and
zenonReleaseTrigger (to unlock the COM object) are subsequently accessed from VSTA (write).

In order to test the COM access quickly very easily, it is possible to insert the following line of code in
the existing button-click event of the user control.

private void buttonAdd Click (object sender, RoutedEventArgs e)
{
if (zenonProject != null)

{

MessageBox.Show (zenonProject.Name) ;

}

return;

¥ Information

A zenOn.Project variable is used in this example. Of course other objects such as
events, etc. of the zenon object model can also be used.



NECESSARY AMENDMENTS IN THE ZENON PROJECT/VSTA CODE

The following steps are necessary in the VSTA code:

Creation of a VSTA macro for the initialization

/// <summary>

/// Macro for API initialization in the WPF User Control

/// </summary>

public void MacroWPFInit ()

{
zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen");
zenOn.IElement myWPFElement = myWPFScreen.Elements().Item(”WPF_Element”);

myWPFElement.set WPFProperty ("AdditionControl", "zenonVariableLink",
this.Variables () .Item(0)) ;

}

Creation of a VSTA macro for approval

/// <summary>

/// Macro for API release in the WPF User Control
/// </summary>

public void MacroWPFRelease ()

{
zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen") ;
zenOn.IElement myWPFElement = myWPFScreen.Elements().Item("WPF_Element");

myWPFElement.set WPFProperty ("AdditionControl", "zenonReleaseTrigger", true);

Create two execute VSTA macro functions that are linked with buttons, which are in the same screen as
the WPF element.

Now start Runtime in order to test the functionality

» Execute the macro for initialization
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» Click on the button in the WPF user control; a message box with the project name of the project
appears

‘ Initialize ‘ ‘ Release ‘

Enter a value

Enter a value

Add Values

Result

TESTPROJECT

» Execute the macro for release

In order to debug the user control, it is possible to proceed as described in the Debugging the WPF user
control in Runtime (on page 29).

! Hint

The initialization and release of the COM object in this example is only carried out for
simple demonstration using VSTA macro functions. Depending on the application, and/or
in practice, events in VSTA are better suited to this.

For example, the code for initialization in the _Open event of the screen can be executed
with the WPF element and the code for release in the Close event.

The mechanism described here is also used in the Display of WPF elements in the zenon
Web Client (on page 90) chapter.

A Attention

If COM objects are used in WPF user controls, these must always be explicitly approved
before destroying the WPF user control (before closing the screen, before closing
Runtime, before reloading).

5.4.2  Access via marshaling

In order to get access to the zenon Runtime COM interface by means of marshaling, proceed as follows.
The creation of a simple WPF user controls with code behind function (on page 23) serves as an initial
example.
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Y Information

The following code is intended to show an example of how the COM implements
access to zenon Runtime and in doing so limits itself to the basic functionality. There
is no explicit error handling, etc.

NECESSARY AMENDMENTS IN WPF USER CONTROL

The following steps are necessary in the WPF user control project (WPFUserControlLibrary).

Firstly, a reference to the zenon COM interface must be incorporated.

a1 Solution "WPFUserControlLibrary' (2 projects)
4 WPFUserControllibrary
b Properties

Reference Manager - WPFUserControlLibrary

P Assemblies

b Projects MName Version

b Shared Projects WPDSp 1.0 Type L.ibrar)r 1.0

wschAPl 1.0 Type Library 1.0

4 COM Wscui.cpl 1.0 Type Library 1.0

WSHControllerLibrary 1.0

WUAPI 2.0 Type Library 20

Recent K5Editor ActiveX Control module 1.0

X5Manitoring ActiveX Control module 1.0

b Erowse XP5_SHL_DLL 1.0 Type Librar}r 1.0

XP5_SHL_DLL 1.0 Type Library 1.0

zenDB5rv 3.0 Type Library 3.0

zenMetSrv 3.0 Type Library 3.0

zenon programming interface library 1.0

After this, the following code must be inserted in the Usercontroll class:
//The zenon Project

zenOn.Project zenonProject = null;

Furthermore, the constructor of the user controls must be supplemented with the lines below (to
initialize the COM object):

/// <summary>

/// Constructor for UserControll, initialize COM Object
/// </summary>

public UserControll ()

{

InitializeComponent () ;

try



zenonProject =

((zenOn.Application)Marshal.GetActiveObject ("zenOn.Application")) .Projects () .Item("TES
TPROJECT") ;

}
catch (Exception)
{
}

The COM object must be approved in the UserControl Unloaded event:
/// <summary>
/// Release COM Object
/// </summary>
private void UserControl Unloaded(object sender, RoutedEventArgs e)
{
try
{
if (zenonProject != null)
{
Marshal.FinalReleaseComObject (zenonProject) ;

zenonProject = null;

}

catch (Exception)
{
}

In order to test the COM access quickly very easily, it is possible to insert the following line of code in
the existing button click event of the user control.

private void buttonAdd Click (object sender, RoutedEventArgs e)
{
if (zenonProject != null)
{
MessageBox.Show (zenonProject.Name) ;

}

return;
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Now build the solution and update the WPF user control in the zenon project.

Start Runtime to test the user control.

Enter a value

Enter a value

Add Values

Result

TESTPROJECT

In order to debug the user control, it is possible to proceed as described in the Debugging the WPF user
control in Runtime (on page 29).

¥ Information

A zenOn.Project variable is used in this example. Of course other objects such as
events, etc. of the zenon object model can also be used.

& Attention

If COM objects are used in WPF user controls, these must always be explicitly approved
before destroying the WPF user control (before closing the screen, before closing
Runtime, before reloading).

¥ Information

No access by means of marshaling is possible in the zenon web client. If access to the
COM interface is required there, the method described in the Access via VSTA "variable
link" (on page 39) must be used.
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6. Engineeringin zenon

In order to be able to use WPF user controls in zenon, version 3.5 (or higher, depending on the .NET
framework version used in the user control) of the Microsoft framework must be used on both the
Editor computer and the Runtime computer.

CONDITIONS FOR THE WPF DISPLAY IN ZENON

The dynamization is currently available for simple variable types (numerical data types as well as string).
Arrays and structures cannot be dynamized.

Therefore the following WPF functions can be implemented in zenon:

» Element properties that correspond to simple data types, such as SString, Int, Double,
Bool etc.

» Element properties of the "Object" type, which can be set with simple data types

» Element events can be used with functions; the parameters of the events are not however
available in and cannot be evaluated in zenon

» Element transformation, for which a RenderTransform is present for the element in the XAML
file

Attention: if the content is outside of the area of the WPF element during transformation, this
is not labeled

Notes on dBase: No shade can be displayed in zenon for WPF elements.

A Attention

If the Runtime files were created for a project for a version before 6.50, existing WP F
elements are not included into Runtime screens.

6.1 CDWPF files (collective files)

A CDWPF file (with the suffix *.cdwpf) is an renamed ZIP file that contains the following components:
» XAMIL file (to reference the user control assembly)
» DLL file (the actual WPF user control, optional)

» Preview graphics (for preview, optional)
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Rules for the use of collective files:

>

>

6.2

The files (XAML, DLL, preview graphics) can be in the CDWPF file directly or in a joint folder.
The name of the collective file should correspond to the names of the XAML file.
Only one XAML file may be contained.

The preview graphic should be small and no more than 64 pixels high.
Name of the preview file: preview.png or the name of the XAML file with the suffix png.

Any number of assemblies can be used. The distinction is made on the basis of the file version.
Collective files do not need to contain an assembly.
All subfolders are examined and only taken into account with *.dll, *.xaml or *.png files.

If a collective file (*.cdwpf) is replaced by a file with a different version, all corresponding COWPF
files in all symbols and images in all projects must be adapted.

create WPF element

To create a WPF element

1.

2
3
4,
5
6

In the elements toolbar, select the symbol for WPF element or the Elements entry in the menu
Select the start point in the main window.

Pull open the element with the mouse.

In properties, select Representation the property XAML file in the group.

The file selection dialog opens.

Select the desired file
Files of the following formats are valid:

e *.xaml: Extensible Application Markup Language
e *.cdwpf: WPF collective file, also shows preview image

(The file must already be present in the Project Manager under Files/graphics or created in the
dialog.)

Configure the links (on page 49).
¥ Information

If referenced assemblies are used, note the instructions in the Referenced assemblies (on
page 8) chapter.
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6.3 Configuration of the linking

To configure a WPF element
1. In properties, select WPF links the property Configuration in the group.

2. The dialog with three tabs opens with a preview of the XAML file and the elements present in
the file

DIALOG CONFIGURATION

Configuration @
| weF element |
wor denert Lo ]
Avaralbl i
i e elements Preview —]
LayoutRoot -
= MyViewBox
MyButton Lote
Action bnk
Properties  Events | Transformations
Linked | Name Linkage # Type of fink | WPF info -
[ EI " Content int Varisbie_Button i
=] IsEnabled Authorization available Authorizatio... True
(m] DataContext <nothing lin...
[0  ContentStringFormat <nothing lin...
(] CommandTarget <nething lin...
O ud <nothing lin...
O  MaxHeight <nothing lin... +unendlich
O Tag <nathing lin...
(] ToolTip <nothing lin,
] CommandParameter <nething lin.
(m] ToolTipService.VerticalOffset <nothing lin... 0
O MaxWidth <nething lin... +unendlich
[0  ContetMenuSenvice Horizont.. <nothing lin... 0
[m] Typography.AnnotationAltern... <nothing lin... 0
[ ConteahenSanics Usdicalel | |_cnothinalin 0 ]
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Parameters

Available elements

Preview

Properties (on page 51)

Events (on page 57)
Transformations (on page 58)
Name

Connection

Link type

WPF info

Linked

¥ Information

Description

Shows the named file elements in a tree structure. The
selected element can be linked with process data.

WQPF is assigned to process data based on the element
name. Therefore elements are only shown if they and the
attendant elements have a name. Allocations are
configured and shown in the Properties, Events,
Transformations tabs.

Hint: If the corresponding elements are not displayed,
check in the XAML file to see if this has a name (for
example: <Grid Name="GridName">).

The selected element is shown flashing in the preview.

Configuration and display of properties (variables,
authorizations, interlockings, linked values).

Configuration and display of events (functions).
Configuration and display of transformations.
Name of the property.

Selection of link.

Type of link (variable, authorization, function)

Shows the current value for properties in WPF content. For
the user, it is directly visible what type of property it is
(Boolean, string, etc.).

Shows if a property is currently being used.

Not contained by default in the view, but can be selected
using Context menu->Column selection.

Only logical objects can be displayed in the configuration dialog. Visual objects are not
displayed. You can read about backgrounds and how visual objects can be animated in

the Allocation of zenon object to WPF content.

EDIT HYPERLINKS

All configured hyperlinks can be edited from the properties of the element. Click on the element and
open the property group WPF links. Hyperlinks can be further configured here, without having to open

the dialog.

Limitations:

» The linking type cannot be changed here.

» New linkings can only be created via the configuration dialog.
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» Insertion of a WPF elements into a symbol: WPF linkings cannot be exported.

6.3.1 Properties

The properties enable the linking of:
» Variables (on page 53)
» Values (on page 54)

» Authorizations and interlockings (on page 55)

Configuration @
WPF element
o denent Lo ]
M .
walable elements Preview —]
LayoutRoot -
=1 MyViewBox
MyButton L tee |
Action bnk
Properties Evenl.sl Trmsfo:mermsl
Linked | Name Linkage # Type of fink | WPF info -
L Content t Varsbie Buton
=] IsEnabled Authorization available Authorizatio...  True
(m] DataContext <nothing lin...
[0  ContentStringFormat <nothing lin...
(] CommandTarget <nething lin...
O ud <nothing lin...
O  MaxHeight <nothing lin... +unendlich
O Tag <nathing lin...
(] ToelTip <nothing lin...
O  CommandParameter <nathing lin...
(m] ToolTipService.VerticalOffset <nothing lin... 0
O MaxWidth <nething lin... +unendlich
[0  ContetMenuSenvice Horizont.. <nothing lin... 0
(m] Typography.AnnotationAltern... <nothing lin... 0
O rontedhenSendics Vericalnl | |_cnathinnlin 0 [




Parameters
Name

Connection

Link type

WPF info

Linked

CREATE LINK

To create a link:

Description
Name of the property.
Linked variable, authorization or linked value.

Clicking in the column opens the respective selection
dialog, depending on the entry in the Link type column.

Selection of linking.

Shows the current value for properties in WPF content.
For the user, it is directly visible what type of property it is
(Boolean, string, etc.).

Shows if a property is currently being used.

Not contained by default in the view, but can be selected
using Context menu->Column selection.

1. Highlight the line with the property that is to be linked

2. Clickin the Link type cell

3. Select the desired link from the drop-down list.

The following are available:

e <not linked> (deletes an existing link)

e Authorization/Interlocking
° Constant value
e Variable

4. Click in the Link cell

5. The dialog for configuring the desired link opens

Q

Information

Properties of WPF and zenon can be different. If, for example the visibility property is
linked, there are three values available in .NET:

0 - visible
1 - invisible

2- collapsed

These values must be displayed via the linked zenon variable.
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Link variable

To link a variable with a WPF property:
1. Highlight the line with the property that is to be linked
2. Click in the Link type cell
3. Select from the variable drop down list
4. Click in the Link cell
5

The dialog for configuring the variables opens

This dialog also applies for the selection of variables with transformations (on page 58). The
configuration also makes it possible to convert from zenon into WPF units.

Configuration @
Linked variable ;JOK
D Cancel
Range of values of the WPF element

[~ Conwvert range of values

Minimum Maximum




Parameters Description

Linked variables Selection of the variable to be linked. A click on the ...
button opens the selection dialog.

Value range of WPF element Data to convert variable values into WPF values.
Convert value range Active: WPF unit conversion is switched on.
Effect on Runtime: The current zenon value (incl.

zenon unit) is converted to the WPF range using
standardized minimum and maximum values.

For example: The value of a variable varies from
100 to 200. With the variables, the standardized

range is set to 100 - 200. The aim is to display this
change in value using a WPF rotary knob. For this:

» for Transformations, the RotateTransform.Angle
property is linked to the variables

» Adjust value activated

» a WPF value range of 0 to 360 is configured

Now the rotary knob can be turned at a value of
150, for example, by 180 degrees.

Minimum Defines the lowest WPF value.
Maximum Defines the highest WPF value.
OK Accepts settings and ends the dialog.
Cancel Discards settings and ends the dialog.
Help Opens online help.

Link values

Linked values can either be a String or a numerical value of the type Double. When selecting the screen,
the selected value is sent in WPF content after loading the WPF content.

To link a value with a WPF property:
1. Highlight the line with the property that is to be linked
2. Click in the Link type cell
3. Select Value linkings from the drop-down list
4

Click in the Link cell
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5. The dialog for configuration of value linking opens

Configuration @
Link constant value
Linked value
Use string Cancel
Numeric value )
Help
Unit
<Base unit> -
Parameters Description
Linked value: Entry of a numerical value or string value.
Use string

String value/numerical value

Unit:

oK

Cancel

Help

Active: A string value is used instead of a numerical value.

The language of string values can be switched. The text is
translated in Runtime when the screen is called up and sent in
WPF content. If the language is switched whilst the screen is
opened, the string value is retranslated and sent.

Depending on what is selected for the Use string property, a
numerical value or a string value is entered into this field. For
numerical values, a unit of measurement can also be selected.

Selection of a unit of measurement from the drop down list. You must
have configured this in unit switching beforehand.

The unit of measurement is allocated with the numerical value. If
the units are switched in Runtime, the value is converted to the
new unit of measurement and sent to WPF content.

Accepts settings and ends the dialog.
Discards settings and ends the dialog.

Opens online help.

Link authorization or interlocking

Authorizations cannot be granted for the whole WPF element. The element is allocated a user level.
Authorizations are granted within the user level for individual controls. If an authorization is active, the

value 1 is written to the element.

To link an authorization or interlocking with a WPF property:

1. Highlight the line with the property that is to be linked

2. Click in the Link type cell
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3. Select Authorization/interlocking from the drop down menu

4. Click in the Link cell

5. The dialog for configuring the authorizations opens

Link authorizationfinterlocking |

Linked status

uthorization available -

Link authorization/interlocking

Setting the authorizations.

Linked status

Selection of an authorization that is linked to a WPF control from
the drop down list. For example, visibility and operability of a
WPF button can depend on a user's status.

Link authorizationfinterlocking |

Linked status

uthorization available

Authorization available

Authorization does not exist
Mot interlocked

Interlocked
Can be operated
Cannot be operated

Authorization available

If the user has sufficient rights to operate the WPF element, a value of 1
is written to the property.

Authorization does not
exist

If the user does not have sufficient rights to operate the WPF element, a
value of 1 is written to the property.

Not interlocked

If the element is not locked, the value 1 is written to the property.

Interlocked

If the element is locked, the value 1 is written to the property.

Can be operated

If authorization is present and the element is not locked, then a value of
1 is written to the property.

Cannot be operated

If authorization is not present or the element is not locked, then a value
of 1 is written to the property.
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6.3.2 Events
Events make it possible to link zenon functions to a WPF element.
Iﬁ
WPF element
o ]
Previen [cne |
| Properties | Events | Transformations | User authorization/nteriocking |
WPF event Linked function o
ContextMenuClosing Function 1 :l
ContextMenuOpening Function 2
DataContextChanged Function 3
DragEnter
DraglLeave
DragOver
Drop
FocusableChanged
GiveFeedback
GotFocus il
Name Name of the property.
Connection Linked function. Clicking in the cell opens the
configuration dialog.
Link type Selection of linking. Clicking in the cell opens the selection
dialog.
WPF info Shows the current value for properties in WPF content.
For the user, it is directly visible what type of property it is
(Boolean, string, etc.).
Linked Shows if a property is currently being used.
Not contained by default in the view, but can be selected
using Context menu->Column selection.

LINK FUNCTIONS

To create a link:

1. Highlight the line with the property that is to be linked




2. Clickin the Link type cell

3. Select from the drop down list function
4. Click in the Link cell
5

The dialog for configuring the function opens

Configuration @
Link function
Linked function ILI
< no function linked = D Cancel
Help
Parameters Description
Linked function Selection of the function to be linked. Clicking on the ...

button opens the dialog for Function selection.

oK Accepts selection and closes dialog.
Cancel Discards changes and closes dialog.
Help Opens online help.

6.3.3 Transformation

The WPF element does not support rotation. If, for example, the WPF element is in a symbol and the
symbol is rotated, the WPF element does not rotate with it. Therefore there is a different mechanism for
Transformation with WPF to turn elements or to otherwise transform them. These transformations are
configured in the Transformation tab.
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Attention: If the content is outside of the WPF element area, this part of the contents is lost or it is not
shown.

ﬁ

WPF element

Available elements Preview Cancel

= LayoutRoot
& yrenox

Button

proparte vt | Tsfmatons s auporzaonerc

WPF transformation Linked variable I

RotateTransform. Angle WIZ_VAR_10
RotateTransform, CenterX Alarms not acknowledged
RotateTransform. CenterY

ScaleTransform, CenterX

ScaleTransform, Centery

SealeTransform, ScaleX.

ScaleTransform. ScaleY

SkewTransform, Anglex

SkewTransform, Angle’

SkewTransform. CenterX




Parameters
Name

Connection

Link type

WPF info

Linked

Description

Name of the property.
Selection of the linked variables.

Transformations are displayed in XAML as transformation objects with their own
properties. If an element supports a transformation, then the possible properties
of the transformation object are displayed in list view. (more on this in: Integrate
button as WPF XAML in zenon (on page 100)

For example, if the linked variable is set at the value of 10, then this value is
written as a WPF target and the WPF element is rotated by 10°.

Selection of transformation link type.

Shows the current value for properties in WPF content. For the user, it is directly
visible what type of property it is (Boolean, string, etc.).

Shows if a property is currently being used.

Not contained by default in the view, but can be selected using Context
menu->Column selection.

LINK TRANSFORMATIONS

To link a transformation with a WPF property:

1. Highlight the line with the property that is to be linked

Click in the Link type cell

Select from the Transformation drop down list

2
3
4. Click in the Link cell
5

The dialog for configuring the variables opens

The configuration also makes it possible to convert from zenon into WPF units.

Configuration
Link variable

Linked variable

Convert range of values

Minimum

Range of values of the WPF element

Maximum
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Parameters

Linked variables

Value range of WPF element

Convert value range

Minimum
Maximum
OK
Cancel

Help

6.4 Validity of XAML Files

Description

Selection of the variable to be linked. A click on the ...
button opens the selection dialog.

Data to convert variable values into WPF values.

Active: WPF unit conversion is switched on.

Effect on Runtime: The current zenon value (incl.
zenon unit) is converted to the WPF range using
standardized minimum and maximum values.

For example: The value of a variable varies from
100 to 200. With the variables, the standardized

range is set to 100 - 200. The aim is to display this
change in value using a WPF rotary knob. For this:

» for Transformations, the RotateTransform.Angle
property is linked to the variables

» Adjust value activated

» a WPF value range of 0 to 360 is configured

Now the rotary knob can be turned at a value of
150, for example, by 180 degrees.

Defines the lowest WPF value.
Defines the highest WPF value.
Accepts settings and ends the dialog.
Discards settings and ends the dialog.

Opens online help.

XAML files are valid subject to certain requirements:

» Correct name spaces
» No class references

» Scalability

CORRECT NAME SPACE

The WPF element can only display WPF content, i.e.:
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Only XAML files with the correct WPF namespace can be displayed by the WPF element. Files that use a
Silverlight namespace cannot be loaded or displayed. However, in most cases it is suffice to change the
Silverlight namespace to the WPF namespace.

WPF-Namespaces:
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation”

xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"

NO USE OF CLASS REFERENCES

Because the XAML files can be loaded dynamically, it is not possible to use XAML files that contain
references to classes ("class" key in header). Functions that have been programmed in
independently-created CH- files cannot be used.

In order to use WPF user controls with code behind, the process as described in the Creating a simple
WPF user control with code behind funciton (on page 23) must be carried out.

SCALABILITY

If the content of a WPF element is adjusted to the size of the WPF element, then the controls of the WPF
element are interlaced in a control that offers this functionality, such as a view box for example. In
addition, it must be ensured that the height and width for this elements are configured as automatic.

CHECKING AN XAML FILE TO SEE IF IT IS CORRECT

To check if an XAML file has the correct format:
» Open XAML file in Internet Explorer

e If it can be opened without additional plug-ins (Java or similar), then it can be assumed with
a high degree of certainty that this file can be loaded or displayed by zenon

e if problems occur during loading, these are then shown in Internet Explorer and the lines in
which problems arise can be clearly seen

The scaling can also be tested in this manner: If the file has been created correctly, the content will
adjust to the size of the Internet Explorer window.

ERROR MESSAGE

If an invalid file is used in zenon, then an error message is displayed in the output window when loading
the file in the WPF element.

For example:
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"error when loading
xaml-Datei:C:\ProgramData\COPA-DATA\SQL\781b1352-59d0-437e-a173-08563c3142e9\
FILES\zenon\custom\media\UserControll.xaml

The attribute "Class" cannot be found in XML namespace
"http://schemas.microsoft.com/winfx/2006/xaml". Line 7 Position 2."

6.5 Pre-built elements

zenon is already shipped with several WPF elements. More are available for download in the web shop.

All WPF elements have properties which determine the graphical design of the respective element
(Dependency Properties). Setting the values via an XAML file or linking the property via zenon can
directly change the look in the Runtime. The tables in the description of the individual elements contain
the respective Dependency Properties, depending on the control.

Available elements:
» Analog clock (on page 64)
» Vertical bar graph (on page 65)
» Comtrade Viewer (on page 66)
» Energy class diagram (on page 77)
» Progress bar (on page 66)
» Pareto diagram (on page 78)
» Sankey diagram (on page 85)
» Round display (on page 82)
» Temperature control (on page 87)
» Universal slider (on page 88)

» Waterfall diagram (on page 89)

REPLACING ASSEMBLY WITH A NEWER VERSION

Per project only one assembly for a WPF element can be used in the zenon Editor as well as in the
Runtime. If two versions of an assembly are available in a project, then the first loaded file is used. A
user enquiry is made as to which version should be used. No further actions are needed for the
maintenance of the versions used up until now. If a newer version is chosen, all corresponding COWPF
files in all symbols and images in all projects must be adapted.

Note for Multi-Project Administration: If an assembly in a project is replaced by a new version, it
must also be replaced in all other projects that are loaded in the Editor or in Runtime.
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6.5.1  Analog clock - AnalogClockControl

ElementStyle Shape/type of element. Enum:
> SmallNumbe
rs

» BigNumbers

> No
ElementBackgroundBrush Color of element background. Brush
ElementGlasReflection Activate the glass effect on the element. Visibility
Offset Value in hours (h) which displays the time lag to the Intlo

system clock.

OriginText Text which is displayed in the clock (e.g. location). String
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6.5.2  Bar graph vertical - VerticalBargraphControl
CurrentValue Current value which should be displayed. Double
MinValue Minimum value of the scale. Double
MaxValue Maximum value of the scale. Double
MajorTicksCount Number of main ticks on the scale. Integer
MinorTicksCount Number of sub ticks on the scale. Integer
MajorTickColor Color of main ticks on the scale. Color
MinorTickColor Color of sub ticks on the scale. Color
ElementBorderBrush Color of the element border. Brush
ElementBackgroundBrush | Color of element background. Brush
ElementGlasReflection Activate the glass effect on the element. Visibility
ElementFontFamily Element font. Font
ScaleFontSize Font size of the scale. Double
ScaleFontColor Font color of the scale. Color
IndicatorBrush Bar graph fill color. Brush
BargraphSeparation Number of bar graph dividion. Integer
BargraphSeparationColor | Color of the scale division. Color




6.5.3

Property

CurrentValue

MinValue

MaxValue
ProgressbarDivisionCount
Visibility Text

TextSize

TextColor
ProgressBarBoxedColor

ProgressBarMarginDistance

ProgressBarlnactiveBrush
ProgressBarActiveBrush

ProgressBarPadding

ElementBorderBrush

ElementBackgroundBrush

6.5.4

Progress bar - ProgressBarControl

Function

Current value which should be displayed.
Minimum value of the value area.
Maximum value of the value area.
Number of divisions of the progress bar.
Visibility of the value display.

Font size of the value display.

Color of the value display.

Color of the border of the progress bar.

Distance of the progress bar box from the element edge (left,
top, right, down).

Indicator color not active.
Indicator color active.

Distance of the progress bar from the progress bar box (left,
top, right, down).

Color of the element border.

Color of element background.

COMTRADE-Viewer

Value
Double
Double
Double
Integer
Boolean
Double
Color
Color

Double

Brush
Brush

Double

Brush

Brush

The COMTRADE-Viewer WPF element is available to partners of COPA-DATA and is available to these via

the Partner Portal.

It is for the graphical analysis of digital error and result logging of a COMTRADE file.

Y Information

The control supports IEEE C37.111 (IEEE Standard Common Format for Transient
Data Exchange (COMTRADE) for Power Systems) standards-compliant files. ASCII or
binary files in accordance with the 1999 or 2013 edition can be visualized.

Older files or files without a year identification are not supported. This is displayed
with a warning dialog in Runtime.
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Possibilities of the COMTRADE-Viewer WPF control in zenon Runtime:

»

»

Selection of a file in the COMTRADE file format
Exports selected objects as an CSV file.

Visualization of the selected COMTRADE file:
Note: The display colors can be configured in the zenon Editor.

e  Current (sinus wave display)

e Voltage (sinus wave display)

e Digital signals (binary bar chart display)

e Display of values at a selected cursor position.

e If an element that represents neither current or voltage is selected, (such as frequency), this
is visualized in both analog areas again (current and voltage).

Navigation:
e Zoom in and zoom out using the mouse wheel, scroll bar and Multi-Touch gestures

e Enlargement of the area
Selection of the area by clicking the mouse

e Move the display area using the right mouse button, scroll bar or Multi-Touch gestures.




! Hint

To be able to transport COMTRADE files to the zenon Runtime computer, you can
also use the file transfer of the 1IEC 61850 driver or the FTP function block of zenon
Logic.

You can find further information about this in the driver documentation of the IEC
61850 driver or in the zenon Logic documentation.

LICENSING

The COMTRADE-Viewer can only be configured in the zenon Editor with a valid Energy Edition license. If
there is no valid license, the WPF is displayed as grayed out in the Editor. A valid Energy Edition license is
also required for display in Runtime.

Mo Energy Edition license found!

Display during Runtime

The COMTRADE WPF element offers two views in Runtime:
» Configuration view
e Selection of a COMTRADE configuration file
e Selection of the elements to be displayed
» Graph view
e Zoom in and zoom out
e Display of values at a selected cursor position.

e  Export of the selected elements as an CSV file

¥ Information

The switch between the views is integrated in the WPF element. Additional project
configuration of a screen switching function is not necessary.
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Runtime view - configuration page

If a screen with a configured COMTRADE-Viewer WPF element is called up, the display of the respective
configuration page is empty.

Note: This also applies if, in zenon Runtime, there is a switch from one screen to another screen with
the screen switching function.

uoRenbyuo) 1BMSIA IAVYLINDD ~

COMTRADE VIEWER CONFIGURATION

The COMTRADE Viewer Configuration switching, arranged vertically on the side, switches the display of
the configuration to graphic view and vice versa.

SELECT FILE

The Open... button opens the file selection dialog to select a file.

There is a pre-selection for display in the file selection:

» Indoing so, file pairs of *.cfg- and *.dat files are detected.
Note: Optional *.hdr or *.inf files are not taken into account.

» Only the corresponding * . dat files are displayed.
» Allattendant files (*.dat, *.cfg) are loaded by clicking on the desired file and the OK button.

» One file can be loaded.

69



» After loading the file, the content of the file is shown in the Analog Channels and Digital Channels

columns.

The labels and units of the elements originate from the COMTRADE configuration and cannot be

changed.

ANALOG CHANNELS

Parameters

[Liste der verfiigbaren Kanédle]

Select All

Deselect All

DIGITAL CHANNELS

Parameters

[Liste der verfligbaren Kanédle]

Select All

Deselect All

SHOW SELECTION

Description

Selection of the elements to be visualized.

Multiple selection by clicking on the desired entry in the
list. Selected elements are shown with a colored
background. Another mouse click undoes the selection of
the entry.

Selects all elements from the list.

Deactivates the existing selection of elements.

Description
Selection of the elements to be visualized

Multiple selection by clicking on the desired entry in the
list. Selected elements are shown with a colored
background. Another mouse click undoes the selection of
the entry.

Selects all elements from the list.

Deactivates the existing selection of elements.

To show your selection in the graphic view, click on the Apply button.

Note: Clicking on the vertically-arranged COMTRADE Viewer Configuration switching only changes the
view. An amended selection of the channels is not taken into account in the process.

Runtime view - visualization of COMTRADE data

The selected channels are visualized in the graph view of the COMTRADE-Viewer WPF element. The

coloring can be configured in the zenon Editor.
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EXPORT OF THE SELECTED DATA

The selected analog and digital channels can be exported to a CSV file with the CSV-Export button.

GRAPH VIEW

The graph view of the COMTRADE-Viewers is divided into three sections:

» Current amperage
Upper area

» Voltage
Mid area

» Digital channels
Lower area
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AXIS LABELING

» Horizontal axis
The horizontal axis represents the complete time period as illustrated in the COMTRADE file
(*.dat).
The scaling of this time axis depends on the enlargement level. The higher the enlargement
selected, the more detailed the time display.

» Vertical axis
The vertical axis represents the values.




o The scaling of the value axis depends on the enlargement level. The greater the
enlargement selected, the more detailed the display of values.

o The labeling of the analog channels is shown vertically next to the values and corresponds to
the measuring unit as defined in the COMTRADE file (* . cfqg).

e The digital channels are displayed in the sequence as defined in the COMTRADE file
(*.cfg).
The Channel identifier of the COMTRADE file serves as an identifier.

KEY

1A(A) W IB(A) WICA) T 1G(A)

The color key of the graphs is shown at the head of the graph.

» The labeling of the digital channels corresponds to the channel description as defined in the
COMTRADE file (*.c£q).

» The colors for each channel are assigned automatically with the configured color palette.

» The time is displayed in a footer under the graph. The start time is displayed as a text.

NAVIGATION AND ZzOOM

Navigation (scroll and zoom) is always applied to all three areas of the graphic display.
» You can move the display within the horizontal time line with the scroll bar.
» Zoominand zoom out

e You can zoom at the current position of the mouse pointer in the graphics view or reduce
the enlargement.

e The selected area is displayed by selecting a display area with the mouse button held down.
Note: The display of the values is always amended to the selected area. As a result, this can
lead to a flattening of the curve in the enlarged graphic view.

e Double clicking on the scroll bar resets the enlargement.
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ANALYSIS
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The precise values at the position of the mouse pointer are visualized with a display in value blocks. A
crosshair offers additional visual support with the exact determination of the reading position.

Configurable control properties - color display

ENGINEERING IN THE EDITOR

The element with the name COMTRADE.CDWPF can be configured and placed in each zenon screen

type.
The project configuration of Width [pixels] and Height [pixels] of the element depend on the proportions.
This prevents the COMTRADE-Viewer being displayed as distorted in Runtime.

Note: When configuring the project, ensure that there is sufficient size to guarantee a clear overview.

GRAPHICAL AMENDMENTS

You configure the graphic design in the properties of the WPF element.
You can find further information in the configuration of the linking (on page 49) chapter in this manual.

Possible color values:

» Hexadecimal color values
#RRGGBB

Example color values: #000000 = black , #FFFFFF = white, #FFO000 = red

» Colorvalues by name
Reference: https://msdn.microsoft.com/en-us/library/system.drawing.color.aspx
(https://msdn.microsoft.com/en-us/library/system.drawing.color.aspx)
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15 Hint

The properties for the COMTRADE-Viewer WPF element have a "z" as a starting color. Use
name filtering for a clear display when configuring the linking.

CONFIGURATION PAGE

Text and background color of the configuration page.

Analog Channels

zConfiguratinPageTextColor Text color of the configuration page String

zConfigurationPageBackgroundColor | Background color of the configuration | String

page
BUTTONS
Text and background color of the button.
Open...
zButtonTextColor Text color of the button String
zButtonBackgroundColor Background color of the button String
CHART

Text color of the axis labeling or key and background color.

T T T
50000 60000 70000
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String

zChartTextColor Text color of the axis labeling.
zChartBackgroundColor Background color of the axis labeling String
LABEL

Text and background color of the display of a selected cursor position.
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zChartLabelTextColor

Text color of the value display

String

zChartLabelBackgroundColor

Background color of the value display

String

CHART

Color palette of the graph view and the attendant keys.

zChartPalette

Color palette of the colors for graphs
and keys.

Referencing with color palette name
(see overview).

Default: if no color palette is
configured, the color palette of the
computer's operating system is used.

String

POSSIBLE COLOR PALETTES - OVERVIEW

Arctic B[]
Autumn  HEC TN
Cold D]
Flower HENETNEEN
Forest ERNEENENT
Grayscale IENENTEN
Ground EEEEETE
Lilac [ [ [ [ [ []
Natural HN D EEEE
Pastel NN ENEN

Rainbow EEENT WHE
Spring  [EEEEH
Summer W WO EEE
Warm L [ ]
Windowsg MM EEEN
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6.5.5  Energy class diagram

The energy class diagram, WPF element is available to partners of COPA-DATA and is available to these
via the Partner Portal.

< 18.00 kw

18.00 - 25.00 kKW ' B |

35.00 - 50.00 kW

I
o

o

m

> 50.00 kw

A reaction matrix must be used to model an energy class diagram. This reaction matrix must be linked to
the variable whose value is envisaged for display and distribution in energy classes. The name of the
variable must be transferred to the "zVariableName" property.

REACTION MATRIX FOR ENERGY CLASS DIAGRAM

Function
| <o function linked >
Call via button in screen Alarm Message List

Additional attributes
Limit value color [JHashing

|

Help fie

Help chapter

Additional information 2

[ New status | Delete [ Test ] Up

Status

M1 [ m2 M3 Ems | ms | G 2| m7 = ms
Ener s & revision E rrocress  [E|mimecuT = mvaLo E o= = Fm_m Erv_mr
B AT _va

value AML/CEL

15 8 7 0 [ Jin Alarm Message List
FFEFFFFEFF FEFFFEFFE | To acknowledge

To delete Comment required
Print Send admowledgement to CEL

Limit value text:
Limit Value [[Jin chronological Event List

Alarm/Event Group
0 - <Not used>
State number for counter in the mathematics driver Alarm Event Class
= v 0 - <Not used>

The linked reaction matrix must correspond to the following schematic:

» The first status must be an area, or a "less than" definition




» As many different areas as desired can then be defined.

» The last status must be an area or a "greater than" definition.

The following is applicable for project configuration:

1. If the first status is an area and the value of the variable comes under this area, the first status in
the diagram is shown nevertheless. The same is applicable for the last status the other way
round.

2. The colors that the WPF diagram uses for the classes are the limit value colors that were defined
in the reaction matrix.

3. The letters for the classes are set in alphabetical order starting with "A".

Property Description Value

zenonFontID ID for a font from the first font list (font size is not Integer
taken into account)

zenonNumberOfDecimalPlaces Number of displayed decimal points Integer

zenonVariableName Name of the variable to be displayed. String

Note: Additional VSTA programming is necessary for the display of the energy class diagram in the
zenon web client. You can find details on this in the display of WPF elements in the zenon web client (on
page 90).

6.5.6 Pareto diagram

The Pareto diagram, WPF element is available to partners of COPA-DATA and is available to these via the
Partner Portal.

An example of a Pareto diagram in Runtime is shown below:

100%

50%

25%

Speed Losses
Minor Stops
Breakdown
Cleaning
Unplanned Break
Quality Losses
Changeover

Unplanned Maintenance
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The following settings can be made in the WPF configuration window under COPADATA-ELEMENT:




zenonBarColorl

zenonBarColor2

zenonBarColor3

zenonBarColor4

zenonBarColor5

zenonBarColor6

zenonBarColor7

zenonBarColor8

zenonBarColor9

zenonBarColor10

zenonColorPercentageline

zenonL.ineVisibility

zenonVariablel Label
zenonVariablel Value
zenonVariable2_Label
zenonVariable2_Value
zenonVariable3_Label
zenonVariable3 Value
zenonVariable4 Label
zenonVariable4 Value
zenonVariable5 Label
zenonVariable5 Value
zenonVariable6_Label
zenonVariable6 Value
zenonVariable7_Label

zenonVariable7_Value

Color of the first Bar

Color of the second Bar

Color of the third Bar

Color of the fourth Bar

Color of element fifth Bar

Color of element sixth Bar

Color of element seventh Bar

Color of element eighth Bar

Color of element ninth Bar

Color of element tenth Bar

Color of the percentage line (relative sum
frequency).

Visibility of the percentage line (relative sum
frequency).

Labeling for the 1st Bar
Value of the 1st Bar
Labeling for the 2nd Bar
Value of the 2nd Bar
Labeling for the 3rd Bar
Value of the 3rd Bar
Labeling for the 4th Bar
Value of the 4th Bar
Labeling for the 5th Bar
Value of the 5th Bar
Labeling for the 6th Bar
Value of the 6th Bar
Labeling for the 7th Bar

Value of the 7th Bar

Color
(String)

Color
(String)

Color
(String)

Color
(String)

Color
(String)

Color
(String)

Color
(String)

Color
(String)

Color
(String)

Color
(String)

Color
(String)

Boolean

String
Double
String
Double
String
Double
String
Double
String
Double
String
Double
String

Double
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zenonVariable8 Label
zenonVariable8 Value
zenonVariable9 Label
zenonVariable9 Value
zenonVariablel0 Label

zenonVariablel0 Value

Labeling for the 8th Bar
Value of the 8th Bar
Labeling for the 9th Bar
Value of the 9th Bar
Labeling for the 10th Bar

Value of the 10th Bar

The following events can be used and linked to zenon functions:

Event

zenonBarl1Click

zenonBar2Click

zenonBar3Click

zenonBar4cClick

zenonBar5Click

zenonBar6Click

zenonBar7Click

zenonBar8Click

zenonBar9Click

zenonBar10Click

Function

Function that is executed when the 1st bar is
clicked on.

Function that is executed when the 2nd bar is
clicked on.

Function that is executed when the 3rd bar is
clicked on.

Function that is executed when the 4th bar is
clicked on.

Function that is executed when the 5th bar is
clicked on.

Function that is executed when the 6th bar is
clicked on.

Function that is executed when the 7th bar is
clicked on.

Function that is executed when the 8th bar is
clicked on.

Function that is executed when the 9th bar is
clicked on.

Function that is executed when the 10th bar is
clicked on.

String
Double
String
Double
String

Double

Value

Function

Function

Function

Function

Function

Function

Function

Function

Function

Function
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6.5.7

Property

CurrentValue
IsReversed
ElementFontFamily
MinValue

MaxValue

ScaleRadius
ScaleStartAngle
ScaleLabelRotationMode

ScaleSweepAngle
ScaleLabelFontSize
ScaleLabelColor
ScaleLabelRadius
ScaleValuePrecision

PointerStyle

MajorTickColor
MinorTickColor
MajorTickSize
MinorTickSize
MajorTicksCount
MajorTicksShape

Circular gauge control

Function

Current value which should be displayed.

Scale orientation - clockwise or anti-clockwise.

Element font.

Minimum value of the scale.
Maximum value of the scale.
Radius of the scale.

Angle at which the scale starts.

Alignment of the scale caption.

Angel area which defines the size of the scale.
Font size of the scale caption.

Font color of the scale caption.

Radius on which the scale caption is orientated.

Accuracy of the scale caption.

Shape of the pointer displaying the value

Color of main ticks on the scale.
Color of sub ticks on the scale.
Size of main ticks on the scale.
Size of sub ticks on the scale.
Number of main ticks on the scale.

Shape/type of main ticks on the scale.

Value
Double
Boolean
Font
Double
Double
Double
Double
Enum:

) None
») Automatic

) SurroundI
n

) SurroundO
ut

Double

Double

Color

Double

Integer

Enum:

) Arrow

» Rectangle

> TriangleC
ap

» Pentagon

» Triangle

Color

Color

Size

Size

Integer

Enum:

> Rectangle
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» Trapezoid

» Triangle




MinorTicksShape

MinorTicksCount
PointerSize
PointerCapRadius
PointerBorderBrush

PointerCapStyle

PointerCapBorderBrush
PointerBrush
GaugeBorderBrush
GaugeBackgroundBrush
PointerCapColorBrush
GaugeMiddlePlate
PointerOffset
RangeRadius
RangeThickness
RangeStartValue
RangelEndValue
Range2EndValue
Range3EndValue
Range4EndValue
Range5EndValue
Range6EndValue
RangelColorBrush
Range2ColorBrush
Range3ColorBrush
Range4ColorBrush
Range5ColorBrush
Range6ColorBrush

Shape/type of sub ticks on the scale.

Number of sub ticks on the scale.
Size of the pointer.

Size of the pointer fastening point.
Color of pointer border.

Shape/type of pointer fastening point.

Color of pointer fastening point.

Color of pointer.

Color of the element border.

Color of element background.

Color of pointer fastening point.

Radius of the element background middle plate.
Offset of the pointer (displacement).

Radius of the total range display.

Thickness of the total range display.

Start value of the total range display.

End value of the 1st area and start value of the 2nd range.
End value of the 2nd area and start value of the 3rd range.

End value of the 3rd area and start value of the 4th range.

End value of the 4th area and start value of the 5th range.
End value of the 5th area and start value of the 6th range.
End value of the 6th range.

Color of the first range.

Color of the second range.

Color of the third range.

Color of the fourth range.

Color of element fifth range.

Color of element sixth range.

Enum:

> Rectangle
> Trapezoid
> Triangle
Integer
Size

Double
Brush

Enum:

> BackCap
> FrontCap
) Screw
Brush

Brush

Brush

Brush

Brush
Double
Double
Double
Double
Double
Double
Double
Double
Double
Double
Double
Brush

Brush

Brush

Brush

Brush

Brush
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ScaleOuterBorderBrush Color of the scale border. Brush
ScaleBackgroundBrush Color of scale background. Brush

ValueTextFrameStyle Shape/type of value display. Enum:

) LargeFram
e

) SmallFram
e

> None
ValueTextContent Content of the value display. Enum:
b Text

) TextValue

> Value
ValueTextSize Font size of the value display. Double
ValueTextColor Font size of the value display. Color
IsGlasReflection Activate the glass effect on the element. Boolean
GaugeOffsett Lowering the rotation point of the whole element. Double

6.5.8  Sankey diagram

The Sankey diagram, WPF element is available to partners of COPA-DATA and is available to these via
the Partner Portal.

The Sankey wizard must be used to model a Sankey diagram. The wizard creates an XML file that is then
evaluated by the WPF element. To do this, the zSankeyName property must be given the name of the
XML file. The XML file must be in the Other folder of a project. This is saved there by the wizard.

An example of a Sankey diagram in Runtime is shown below:

The following settings can be made in the WPF configuration window under COPADATA-ELEMENT:

85



Property Function Value

FontSize Font size of the texts. Integer
zBackgroundColor Background color of the diagram. Color
(String)
zFontColor Color of the texts. Color
(String)
zFontFamily Font of all texts. Font
(String)
zLossDetectionActive Automatic loss detection activated/deactivated. If Boolean

true, then losses are automatically shown at a
node points as flows.

zNoDataText Text that is displayed if there are no values to String
display and zPrevireActive is false.

zNoValidXMLText Text that is displayed if no valid XML file with String
entered name has been found and zPreviewActive
is false.

zNumberOfDecimalPlaces Denotes how many decimal places are to be Integer
displayed.

zPreviewActive Display of a preview activated/deactivated. Boolean

The preview can be displayed if

There is no data present (the modeled diagram is
filled with default values) or

the XML file was not found or

this does not contain a valid definition (an example
Sankey diagram is displayed).

zRefreshRate Rate at which the diagram is refreshed in ms. Integer

zSankeyName Name of the XML file with the modeling of the String
diagram.

zShowRelativeValues Display of the values in absolute false or relative Boolean

values true.

Note: Additional VSTA programming is necessary for the display of the Sankey class diagram in the
zenon web client. You can find details on this in the display of WPF elements in the zenon web client (on
page 90).
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6.5.9

Property
CurrentValue
MinValue
MaxValue
MajorTicksCount
MinorTicksCount

TickNegativColor

TickPositivColor

MinorTickColor

ElementBorderBrush

ElementBackgroundBrush

ElementGlasReflection
ElementFontFamily
IndicatorColor
IndicatorBorderColor
MajorTickSize
MinorTickSize

ScaleLetteringDistance

IndicatorScaleDistance
ScaleFontSize
ScaleFontColor

Unit

ElementStyle

Temperature indicator - TemperaturelndicatorControl

Function

Current value which should be displayed.
Minimum value of the scale.

Maximum value of the scale.

Number of main ticks on the scale.
Number of sub ticks on the scale.

Color of the negative main tick (gradient to
TickPositivColor).

Color of the positive main tick (gradient to
TickNegativColor).

Color of the sub ticks.

Color of the element border.

Color of element background.

Activate the glass effect on the element.
Element font.

Color of the indicator fill color.

Color of the indicator border.

Size of main ticks on the scale.

Size of sub ticks on the scale.

Distance of the scale caption (vertical), each x. main tick

should be captioned.

Distance between indicator and scale (horizontal).
Font size of the scale.

Font color of the scale.

Unit.

Shape/type of element.

Value
Double
Double
Double
Integer
Integer

Color

Color

Color
Brush
Brush
Visibility
Font

Color
Color

Size

Size

Integer

Double
Double
Color
String
Enum:

» SmallFram

e
> Unit
> None
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6.5.10 Universal slider -

Property

CurrentValue
ElementFontFamily
MinValue

MaxValue

Radius

ScaleRadius
ScaleStartAngle
ScaleLabelRotationMode

ScaleSweepAngle
ScaleLabelFontSize
ScaleLabelColor
ScaleLabelRadius
ScaleValuePrecision

ElementStyle

MajorTickColor
MinorTickColor
MajorTickSize
MinorTickSize
MajorTicksCount
MajorTicksShape

UniversalReglerControl

Function

Current value which should be displayed.
Element font.

Minimum value of the scale.

Maximum value of the scale.

Radius of the scale.
Angle at which the scale starts.

Alignment of the scale caption.

Angel area which defines the size of the scale.
Font size of the scale caption.

Font color of the scale caption.

Radius on which the scale caption is orientated.

Accuracy of the scale caption.

Display type of the element

Color of main ticks on the scale.
Color of sub ticks on the scale.
Size of main ticks on the scale.
Size of sub ticks on the scale.
Number of main ticks on the scale.

Shape/type of main ticks on the scale.

Value

Double

Font

Double
Double
Double
Double
Double

Enum:

) None

») Automatic
) SurroundIn

) SurroundOu
t

Double
Double

Color

Double
Integer
Enum:

>  Knob

> Plate

> None
Color

Color

Size

Size

Integer
Enum:

» Rectangle
» Trapezoid

» Triangle
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MinorTicksShape

Shape/type of sub ticks on the scale.

Enum:
> Rectangle
> Trapezoid

» Triangle

MinorTicksCount Number of sub ticks on the scale. Integer
BackgroundBorderBrush Color of the element border. Brush
BackgroundBrush Color of element background. Brush
PointerCapColorBrush Color of pointer fastening point. Brush
GaugeMiddlePlate Radius of the element background middle plate. Double
ValueFontSize Font size of the value display. Double
ValueFontColor Font size of the value display. Color
IsGlasReflection Activate the glass effect on the element. Boolean
KnobBrush Color of the knob. Brush
IndicatorBrush Color of the indicator. Brush
IndicatorBackgroundBrush Background color of the inactive indicator. Brush
KnobSize Diameter of the knob. Double
KnoblIndicatorSize Indicator size of the knob. Size
ElementSize Size of the element. Size
VisibilityKnob Activating of the knob. Boolean
ValuePosition Position of the value display. Double
ValueVisibility Activating the value display. Boolean

6.5.11 Waterfall diagram

The waterfall diagram, WPF element is available to partners of COPA-DATA and is available to these via
the Partner Portal.

The meaning and waterfall chart wizard must be used to model a waterfall diagram. A waterfall can be
modeled with this wizard. The information is saved directly for the variables concerned in the Analyzer
--> Parameters for waterfall diagram.

89



An example of a waterfall diagram in Runtime is shown below:

Cleaning 0:00:08

Changeover 0:00:00
Unpl. Maintenance 0:00:09

Unplanned Break 0:00:00
Breakdown [ 0:00:42

operaing Time | 00252
Mincr Stops l:l 0:00:53

Speed Losses _ 0:0L:33

Net Operating Time -

Quality Losses

Valuable Operating -

0:00:25
0:00:00

0:00:24

Note: This screenshot is only available in English.

03.64 %
00.00 %
04.25%
00.00 %
1839 %
1372 %
2277 %
40.24 %
10.72 %
00.16 %

10.56 %

The following settings can be made in the WPF configuration window under COPADATA-ELEMENT:

used.

Property Function Value

zenonRefreshRate Time between the refreshes of the | Integer
diagram in ms.

zenonWaterfallldentifier Name of the waterfall diagram. String

zenonZSystemModel Equipment group of the variables String

Note: Additional VSTA programming is necessary for the display of the waterfall diagram in the zenon
web client. You can find details on this in the display of WPF elements in the zenon web client (on page

90).

6.6 Display of WPF elements in the zenon web client

In order to also be able to also use the pre-made WPF elements "energy class diagram", "Sankey

diagram” and "waterfall chart” for the display in a zenon web client, amendments are necessary in the

project:

» Engineering in the zenon Editor (on page 91)

» Adapt VSTA code (on page 91)
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6.6.1 Engineering in the zenon Editor

Carry out the following project configuration steps in the zenon Editor, in order to also be able to display
certain WPF elements in the zenon web client:

PLACE WPF IN THE ZENON SCREEN:

» Place the WPF element in a zenon screen.

» Give it a unique name in the Element name property.
You can find this property in the General properties group.
Note: A warning dialog appears if the name for an element has already been issued in another
screen.

» Use the element name issued here in the VSTA code.

6.6.2  VSTA code (complex)

In order to add the programmer code for the display of WPF elements in the zenon web client, carry out
the following steps:

1. Inthe zenon Editor, switch to the programmer interfaces node.

2. Select the VSTA node and select the Open VSTA Editor with project add-in... with a right mouse
click

The dialog to create a VSTA project is opened.
Select the C# entry in the Create new VSTA project dialog.

Create (copy) the code below.

o v M W

Enter the name of the WPF element in the code.

Note: When opening the VSTA editor, note whether the content of the following code is already
present in the project configuration. For the display of the WPF element in the web client, compare the
existing code and undertake the necessary additions. Please note the comments in relation to this in the
model code.

VSTA CODE

//As member:

zenOn.IDynPictures zScreens = null;
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string[] WPFElements ={"WPF_Control", "WPFWebclient 1", "WPFWebclient 2" }; //Names of the

WPF screen elements that appear in the zenon project and that need access to the API

many/few as you want)
Y Y

//Add the following three lines of code in the project archive function:
void ThisProject Active()
{
zScreens = this.DynPictures();
zScreens.Open += new zenOn.DDynPicturesEvents OpenEventHandler (zScreens_ Open) ;
zScreens.Close += new zenOn.DDynPicturesEvents CloseEventHandler (zScreens Close);
}
//Add the following two lines of code in the project inactive function:
void ThisProject Inactive()

{

zScreens.Open -= new zenOn.DDynPicturesEvents OpenEventHandler (zScreens Open);

zScreens.Close -= new zenOn.DDynPicturesEvents CloseEventHandler (zScreens Close);

//Final release and garbage collection of any API-Objects.

FreeObjects () ;

//Add two new event handlers:
void zScreens Open (zenOn.IDynPicture obDynPicture)
{
foreach (string element in WPFElements)
{
if (obDynPicture.Elements().Item(element) != null)

{
obDynPicture.Elements () .Item(element) .set WPFProperty ("ELEMENT",

"zenonVariableLink", this.Variables().Item(0));

}

}

void zScreens Close(zenOn.IDynPicture obDynPicture)

{

foreach (string element in WPFElements)

{

if (obDynPicture.Elements().Item(element) != null)

{

(as

92



zenOn.IElement zWPFElement= obDynPicture.Elements().Item(element);
zWPFElement.set WPFProperty ("ELEMENT", "zenonTrigger", true);

zWPFElement = null;

6.6.3  VSTA code (simplified)

If only one WPF element is used in a zenon screen, the following more streamlined code can be used as
an alternative. To do this, the names of the WPF element, and the screen in which the element is used,
must be entered. This code is then recommended if, for each project, only one of the pre-made WPF
elements is used.

VSTA CODE

zenOn.IDynPicture zScreen = zero;
string wpfElement = "WPF_Control"; //Name of the WPF element in the screen

string wpfPicture = "@Details_Overview Online"; //Name of the zenon screen

//Add to the project active function:

void ThisProject Active()

{
zScreen = this.DynPictures().Item(wpfPicture);
zScreen.Open += new zenOn.OpenEventHandler (zScreen Open) ;

zScreen.Close += new zenOn.CloseEventHandler (zScreen Close);

//Add to the project inactive function:
void ThisProject Inactive()
{
zScreen.Open -= new zenOn.OpenEventHandler (zScreen Open) ;

zScreen.Close -= new zenOn.CloseEventHandler (zScreen Close) ;

//Final release and garbage collection of any API-Objects.

FreeObjects () ;
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void zScreen Open ()

{
if (zScreen.Elements().Item(wpfElement) != null)
{

zScreen.Elements () .Item(wpfElement) .set WPFProperty ("ELEMENT",

"zenonVariableLink", this.Variables().Item(0));

}

void zScreen Close()

{

if (zScreen.Elements().Item(wpfElement) != null)

{
zenOn.IElement zWPFElement = zScreen.Elements().Item(wpfElement);
zZWPFElement.set WPFProperty ("ELEMENT", "zenonTrigger", true);

zWPFElement = null;

6.7 Examples: Integration of WPF in zenon

You can see how XAML files are created and integrated as WPF elements in zenon from the following
examples:

» Integrate button as WPF XAML in zenon (on page 100)
» Integrate bar graph as WPF XAML in zenon (on page 94)

» Integrate DataGrid Control in zenon (on page 106)

6.7.1 Integrate bar graph as WPF XAML in zenon

Example structure:
» Creating a bar graph (on page 15) in Adobe lllustrator and converting it to WPF
» Integrate into zenon

» Linking with variables
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» Adapting the bar graph WPF element

CREATE BAR GRAPH

The first step is to generate a bar graph as described in the Workflow with Adobe lllustrator (on page
15) chapter. To be able to use the XAML file in zenon, insert this in the project tree in the Files/graphics
folder.

INTEGRATE BAR GRAPH

Note: A zenon project with the following content is used for the following description:
» Anempty screen as a start screen
» Four variables from the internal driver for
e Scaleo
e Scale central
e Scalehigh
e Current value

» Avariable from the mathematics driver for displaying the current value (255)

To integrate the bar graph:

1. open the empty screen

2. place a WPF element (on page 48) in the screen
3. select XAML file in the properties window
4

Select the desired XAML file (for example bar graph_vertical.xaml) and close the dialog
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ADJUST BAR GRAPH

Before configuration, the scale of the XAML file is adapted if necessary:

counting Value

To do this:

e Create a new mathematics variable that calculates the new value in relation to the scaling,

for example:

e Variable: 0-1000
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Engineering in zenon

Zzenon

e Mathematic variable {value created in xaml file}*Variable/1000

Properties: Variable: calculation - Project: DOKU * O X

E]
g
2
| »

|
|

;
§

1

:
;
:

[E=]

Limits
Value calculati

Calculaton active < no variable linked >

ju]

Decimals 0
Formula 3507%01/100
Hysteresis

&)

&)

Value adjustment linear

&)

Value adjustrment non-linear —

&)

Value range PLC

]ﬁ'Proper‘ties: Variable: calculation - Project: DOKU E ngeﬂ hele

The XAML file is then configured.

CONFIGURE BAR GRAPH

1. Click on the WPF element and select the Configuration property

2. The configuration dialog shows a preview of the selected XAML file.




3.

Engineering in zenon

WPF element
Avaiable elements
= COPA_DATA
- Bargraph
{-min
i mid
- max

Action bnk.

Imﬂlnamml
Name: Lnkage

Datal oot

liskesels

Typeofink | WFFimfo M Linked |

| File W Fiterted 3::-:--:3
ActualHeight <nathing linked> 52,9307402502... [m]
ActualWidth <nothing linked> 52 [m}
AllowDrop <nothing linked>  False a
BorderThickness <nothing linked> 0,000 o
ClipToBounds <nothing linked>  False m]
Content Varisble 128 (]
ContentStringFormat <nathing linked> O
ContextMenuService.HasDro... <nothing linked>  False a
ContextMenuService. Horizon,.. <nothing linked> 0 [m}
ContextMenuServicelsEnabled <nothing linked>  True [m]
ContextMenuService.Placem... <nothing linked> MousePoint [m]
ContextMenuService. Placem... <nathing linked>  Empty a
ContestMenuService. ShowD... <nothing linked>  False [m]
ContextMenuService.Vertical... <nothing linked> 0 [m]
=]

[y »

OK

= ]

Zzenon

Select the minimum value, the average value and the maximum value and link each of these to
the corresponding variable in the Content property

[‘Configuration

VP element |




Engineering in zenon ﬂ

Zzenon

4. Select the slider and link the Value property to the mathematics variables (in our example:

Configuration
WPF clement |
p— [ ]
Available elements [—]
= COPA_DATA
&
-min
- mid
- max
Action ink
Em:pe«m Evenlsl Transfa-mﬁonsl
Name Linkage " Type of Ink | WPFinfo | Lirke =
[ e W | o ]
| FlowDirection <nothing linked> LeftToRight O [=
| Focusable <nothing linked>  True ]
| FontSize <nothing linked> 12 ]
| FontStretch <naothing linked>  Normal (m]
| FontStyle <naothing linked>  Normal m]
| FontWeight <nothing linked>  MNormal ]
| ForceCursor <nothing linked> = False m]
| Grid.Column <nothing linked> | 0 (]
| Grid.ColumnSpan <nething linked> | 1 (]
| Grid.Row <nothing linked> | 0 m]
| Grid.RowSpan <nothing linked> 1 m]
HasAnimatedProperties <nothing linked> = False m]
) Maths Vanisble n. def, (=)
| HnriznntalAlisnment <nnthinn linked> | Rinkt II'I sl
4 nr L3
calculation)

5. Check the project planning in Runtime:

counting Value _




6.7.2 Integrate button as WPF XAML in zenon

Example structure:
» Creating a button (on page 11) in Microsoft Expression Blend
» Integrate into zenon
» Link to a variable and a function
» adjust the button to the size of the element

» Create button

As a first step, create a button as described in the Create button as XAML file with Microsoft Expression
Blend (on page 11) chapter. To be able to use the XAML file in zenon, insert this in the project tree in the
Files/graphics folder.

INTEGRATE BUTTON

Note: A zenon project with the following content is used for the following description:
» Anempty screen as a start screen
» aninternal variable int of type Int
» afunction Funktion_0 of typeSend value to hardware with:
e Direct to hardware option activated

e Setwassetto 45

To integrate the button:
1. open the empty screen
2. place a WPF element (on page 48) in the screen
3. select XAML file in the properties window
4. select the XAML file (e.g. MyButton.xaml and close the dialog
5

select the Configuration property
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CONFIGURE THE BUTTON

The configuration dialog shows a preview of the selected XAML file. All elements named in the XAML file
are listed in the tree:

Configuration [
WPF element
WPF glement \LI
Available elements Preview m
LayoutRoot -
8 =

Button

Action lnk
Properties Events | Transformaton: |
Linked | Name Linkage # Type of ink | WPF info -
[m] . ActuzlHeight <nothing lin... 30
[m] ActualWidth <nething lin... 50
[m] AllewDrop <nothing lin... False
(m] BorderThickness <nething lin.. 1111
(] ClickMode <nething lin... Release
[m] ClipToBounds <nothing lin... False
(m] Command <nothing lim...
m] CommandParameter <nething lin...
O CommandTarget <nothing lin...
[T Content int Variable Button |
O ContentStringFormat <nothing
O ContextMenuService. HasDrop... <nething lin...  False
O  ContetMenuService Horizont... <nething lin... 0
(m] ContedtMenuServicesEnabled <nothing lin... True
[ CentecthlenuSenics Placsoment | |_cncthinalin_ WMaussDoint s
1. select the WPF button, which is in LayoutRoot->MyViewBox->MyButton
2. Look in the Properties EntryContent tab; this contains the button's text
3. Click the Link type column
4. Select Variable from the drop down list
5. Click in the Link column
6. the variable selection dialog is opened
7. select the int variable to link this variable with the Content property
EVENTS

To also assign events:
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1. select the events tab

Configuration
WPF element
Available elements Preview
LayoutRoot
=- M.'y\hemﬂox -~
.

:Pmnerlie-; Events | Transformations | User authorization/Interlocking |

WPF event Linked function
Click Function 0
ContextMenuClosing

ContextMenuOpening

DataContextChanged

DragEnter

DraglLeave

DragQver

Drop

FocusableChanged

GiveFeedback

i §

2. look for the 'Click' entry, this event is triggered by the WPF element, as soon as the button is

clicked
Click in the Link type column
Select Function from the drop down list

Click in the Link column

3
4
5
6. the function selection dialog is opened
7. select Function_0

8. Confirm the changes with OK

9. Insert a numerical value element into the screen

10. Link this numerical value element to the int variables too.

11. Compile the Runtime files and start Runtime.
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The WPF element is displayed in Runtime, the button text is 0. As soon as you click on the button, the
click event is triggered and the set value function is carried out. The value 45 is sent directly to the
hardware and both numerical value and button display the value 45

45 e

Define a set value of 30 via the numerical value element; this value is then also assumed by the WPF
element.

AUTHORIZATION

Similar to a numerical value, a WPF element can be locked according to authorizations (lock symbol) or
switched to be operable. Set the user authorization level to 1 for the WPF element and create a user
called Test with authorization level 1. In addition, set up the functions Login with dialog and Logout .

You link these two functions with 2 new text buttons on the screen.

In the WPF element configuration dialog, select the MyButton WPF button and select the Properties: tab

Konfiguration @
WPF-Element
WPF-Element X |
jorhandene Elemente Vorsch,
Varhandene Elemen Vorschau - |
LayoutRoot
= MyViewBox F Hife |
MyButton
Alcbonsverknupfungen
Sgenschaften Ereignisse | Transformationen
Name Veskruipfung L] Verknupfungsart | WP F-info Verknipft
InputMethod.lsinputhethodE... «<nichts verknupft> False O
InputMethed lslnputMethods... <nichts verkniipft>  False O
InputMethod. PreferredimeCo... <nichts verknipft>  DoMotCare (]
InputMethod.PreferredimeSen.. <nichts verkndpft> DoNotCare m]
InputMethod. PreferredlmeState «nichts verkndpft> DoMNotCare O
IsArrangeValid <nichts verkndpft>  True O
IsCancel <nichts verknipft>  False ]
IsDefault <nichts verknipft>  False O
IsDefaulted <nichts verkndpft>  False O
[ IsEnabled [
IsFocus <nichts verknipft>  False O
IsHitTestVisible <nichts verknapft>  True O
lslnitialized <nichts verknipft>  True (]
TelnpsthdethndFnahled <nichts verkniinfts | Falze [
4 11 '
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1. Select the IsEnabled element
2. Click in the Link type column
3. Select Authorizations/interlocking from the drop down list
4. Click in the Link column
5. Inthe drop-down list, select the Authorized option
Configuration @
Link authorizationfinterlocking |
Linked status
agmsr.?ohg‘l;ddoes not exist Help

Interlocked
Can be operated
Cannot be operated

6. Close the dialog with OK

Compile the Runtime file and note that Authorizations to be Transferred must also be selected. After
Runtime has been started, the WPF button is displayed as deactivated on the screen and cannot be
operated. If you now log in as the user Test, the button is activated and can be operated. The button is
locked again as soon as you log out.

.El

n [ |

TRANSFORMATION

The XAML files must still be adapted to use transformations:
1. switch to the Expression Blend program

2. select MyButton, so that the properties of the element are visible in the events window

¥ Transform
RenderTransform

B 5 & z B ®
0 ]
2

o .

| Apply relative transform

3. Under Transform at RenderTransform select the Apply relative transform option
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As a result of this, a block is inserted into the XAML file, which save the transformation settings

in runtime.

<Button.RenderTransform:
<TransformGroup>
<ScaleTransform ScaleX="1" ScaleY="1"/>
<SkewTransform AnglexX="@" Anglev="8"/>
<RotateTransform Angle="a"/>
<TranslateTransform X="8" ¥Y="8"/>
</TransformGroup>
</Button.RenderTransform:

Save the file and replace the old version in zenon with this new file.
Open the WPF element configuration dialog again:
a) select the MyButton button

b) select the Transformations tab

Configuration
WPF element
T
Available elements Preview Cancel
LayoutRoot
=] My Hi
M.y\hemﬂox — - I o

Button

:Pmnerlie-i lEvenis| Transformations | User authorization/Interlocking |

WPF transformation Linked variable -
RotateTransform. Angle nt
RotateTransform.CenterX

RotateTransform.CenterY
ScaleTransform, Center) 3
ScaleTransform. CenterY
ScaleTransform. ScaleX
ScaleTransform, ScaleY
SkewTransform. AngleX
SkewTransform, AngleY
SkewTransform. Center)

c) select the RotateTransform.Angle element

d) Click in the Link type column

e) Select Transformations from the drop down list
f) Click in the Link column

g) the variable selection dialog is opened

h) select the int variable to link this variable with the RotateTransform.Angle property
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Compile the Runtime files and start Runtime. Log in as the Test user and click on the button. The button
has the value 45 and the WPF element rotates by 45°.

Zj\ 45

Login 1 ‘ Logout 1

6.7.3  Integrate DataGrid Control in zenon

To create DataGrid control for zenon, you need:

» Visual Studio (Visual Studio 2015 in this example)

CREATE WPF USER CONTROL

1. in Visual Studio, create a new Solution and a WPF User Control Library project in .NET
Framework version 4 or higher therein.

Info: If the corresponding project template does not appear in the list of available templates,
this can be added by means of the search (field at the top right of the dialog).

106



New Project ?

P Recent NET Framework 4.5 = Sort by: Default v & i= User Control X -

4 |nstalled - i
g WPF User Control Library Visual C# Type: Visual C#
4 Templates Windows Presentation Foundation user

- VB -
4 Visual G LY WPF User Control Library Visual Basic control library
af

P Windows
Web

I Office/SharePoint
Android
Cloud
Extensibility

b i0S
LightSwitch
Mobile Apps
Reporting
Sitverlight
Test
WCF
Workflow

Visual Basic

Visual C++
Visual F#
SQL Server

b lwaSerint -

P Online

Name: DataGridControlLibrary

Location: Di\sources\ =

Solution name: DataGridControlLibrary [¥] Create directory for solution
"] Add to source control

| 0K | | Cancel

In our example, the project is given the name DataGridControlLibrary.
Create a new data connection in the Server Explorer.

In our example, the database Northwind is used, which is provided by Microsoft as an example
database that can be downloaded for free.

Te set up the database connection:

a) Right-click on Data Connections.

b) Select Add connection....

c) SelectMicrosoft SQL Server (SQLClient) as Data source.

d) Select the corresponding server and database name.
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After adding the connection, the Server Explorer window should look a little like this:

Server Explorer
¢ |lwEi ok
4 gW Data Connections
4 | dbserver\zenon_2012.northwind.dbo
Pl Tables
ER Categories
R Contacts
FR CustomerCustomerDemo
BB CustomerDemographics
FR Customers
EH Employees
EH EmployeeTerritories
R Order Details
R Orders
ER Products
B Region
B Shippers
B Suppliers
R Territories
Views

e A A

Stored Procedures
Functions
Synocnyms

Types

v v v v w7

Assemblies

A new DataSet is created in the next step.

CREATING A DATASET

Right-click on the project
Select Add - New Item... in the context menu
Create a new DataSet with the name DataSetl1.

Double click on the DataSet in order to open it in the Designer.

LA S

Drag the tables that you need (Customers and Orders in this example) to the DataSet design
window.

PR AR ARl Source Control Explorer

Server Explorer
¢ s
4 ¥ Data Connections

4 E dbserver\zenon_2012.northwind.dbo

ok

EH Suppliers
R Territories
Views

shu Fill,GetData ()

The XAML file is modified in the next step.

‘ gblcest . % CustomerlD re—cel ¥ OrderlD A
E m CE Etg&;IES CompanyMame CustomerlD
ontacts
b EH CustomerCustomerDemo ContactName EmployeelD
I EH CustomerDemographics ContactTitle OrderDate
I EH Customers Address RequiredDate
b EH Employees City ShippedDate
I BB EmployeeTerritories Region ShipVia
b FEH Order Details PostalCode Freight
b FEH Orders Country ShipName
b EH Products Phone ShipAddress
I FH Region Fax ShipCity
I ER Shippers ] CustomersTableAdapter ShipRegion v
I
I

& OrdersTableAdapter @
shu Fill,GetData ()
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CONFIGURATION OF THE XAML FILE

1.

If not already there, add the Namespace as a reference to the class in the XAML file:

<UserControl x:Class="DataGridControllibrary.UserControll™
wmlns="http://schemas.microsoft. com/winfx/2806/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2066/xaml"”
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
xmlns:d="http://schemas.microsoft.com/expression/blend/2668"
wmlns:local="clr-namespace:DataGridControllibrary”|
mc:Ignorable="d"
d:DesignHeight="3@8@" d:DesignWidth="3@8">

Define the resources and the DataGrid that is to be used in the WPF:
<UserControl.Resources>
<local:DataSet1 x:Key="Dataset1"/>

<CollectionViewSource x:Key="customersvViewSource" Source="{Binding Path=Customers,
Source={StaticResource DataSet1}}"/>

</UserControl.Resources>
<Grid DataContext="{StaticResource CustomersViewSource}">

<DataGrid Name="pataGridl" DisplayMemberPath="companyName"
IltemsSource="{Binding}" SelectedValuePath="customerIiD"
HorizontalAlignment="stretch" VerticalAlighment="stretch"/>

</Grid>

Open the code-behind file (UserControl1.xaml.cs) and insert the following lines in the
constructor:

public UserControl1()
{
InitializeComponent();
DataSetl ds = ((Dataset1)(FindResource("DataSet1")));

DataSet1TableAdapters.customersTableAdapter ta = new
DataSet1TableAdapters.CustomersTableAdapter();

ta.Fill(ds.Customers);

CollectionViewSource CustomersViewSource =
((coliectionviewSource)(this.FindResource("CustomersViewSource")));

CustomersViewSource.View.MoveCurrentToFirst();
}
In doing so, the following happens:
e The DataSet is obtained
e Anew TableAdapter is created

e The DataSet is filled
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e The information is provided to the DataGrid control

The solution can now be built.

BUILD

Now build the solution. The corresponding DLL (DataGridControlLibrary.dll) is created in the output
folder of the project.

Now you have a DLL with the necessary functionality available.

However zenon can only display XAML files that cannot be linked to the code behind file, which is why
an additional XAML file is needed that references the DLL that has just been created.

To do this:
1. Create a further project, again as a WPF User Control Library
2. It was called DataGridControl in our example.

3. Insert a reference to the project that has just been built into this new project.

Reference Manager - DataGridControl

b Assemblies o
4 Projects Name Path Namm
Solution DataGridContralLibrary D:\sources\DataGridControlLibrary'.Dat yEyes

P Shared Projects
b COM

P Browse

4. The XAML files (UserControl1.xaml) looks as follows:

<UserControl x:Class="DataGridControl.UserControll”
wmlns="http://schemas.microsoft. com/winfx/2806/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2066/xaml"”
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2666"
xmlns:d="http://schemas.microsoft.com/expression/blend/2668"
xmlns:local="clr-namespace:DataGridControl”
mc:Ignorable="d"
d:DesignHeight="3@8@" d:DesignWidth="3@8">

<Grid:

</farid>
</UserControl>

5. Because all necessary content is contained in the DLL that has been created and no code-behind
is necessary, delete the following lines:

x:Class="DataGridControl.UserControll"
xmins:local="clr-namespace:DataGridControl"

6. Also delete (for the positioning) the following lines:
mc:lgnorable="4d"

d:DesignHeight="300" d:DesignWidth="300"
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7. Delete the code-behind file (UserControl1.xaml.cs) in this project.
8. Define what is to be displayed in the XAML file.
To do this, modify the XAML file as follows:
<UserControl xmIns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
XmIns:Xx="http://schemas.microsoft.com/winfx/2006/xaml"
XmIns:mc="http://schemas.openxmlformats.org/markup-compatibility/2006"
xmlns:d="http://schemas.microsoft.com/expression/blend/2008"

xmlns:dataGridLibrary="clr-namespace:DataGridControlLibrary;assembly=DataGridCo
ntrolLibrary">

<Grid x:Name="Grid1">

<dataGridLibrary:UserControll Name="DataGridControl" HorizontalAlignment="Left"
VerticalAlignment="Top"/>

</Grid>
</UserControl>

The
“n6xmlns:dataGridLibrary:"clr—namespace:DataGridControlLibrary;assembly:DataGrid
ControlLibrary" defines the namespace dataGridLibrary and stipulates that this should use
the assembly that has been created.

9. Assign a name for the grid.

10. Insert the control dataGridLibrary:UserControl1 from our library and give it a name, because
zenon can only modify objects that have a name.

11. Build the solution.

In the next step, how the DLL and XAML file are added to zenon is explained.

STEPS IN ZENON

1. Open the zenon Editor

2. GotoFile -> Graphics.
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3. Select Add file... in the context menu

ﬂ; User administration

7 SAP intedace

i) Fles =
E‘ Lol Add file...
% HMt Folder new...
3 Te Rename folder...
&2 on Delete folder
o O

I\ History Editor profile 3

@ Project

sbal symbol il Help = |

n 1

tree | ‘%E Network topology

4. Select the XAML file at the save location (UserControl1.xaml from the DataGridControl project)
and add this:

FEMNECE R —RNEETE W S T M )

Status File name | Type Size Preview
- T Filter texd T|Fiter T |Fiter. ¥ Filter texd T
UserControll xaml xaml 0KB

5. Insert the DLL with the functionality for the XAML file.
To do this:
a) Select, in the context menu, File -> OtherAdd file....

b) Select the file DataGridControlLibrary.dll of the first project (DataGridControlLibrary).

T = T S T = )

Status File name Type # Size
:'f'f-v :'f'f- V:'i v:'f v
DataGridControlLibrary.dll dil 36 KB

6. Createa zenon screen.
7. Add a WPF element and select the previously-incorporated XAML file.

You should now see the following in the zenon Editor:

¥ Bud0- 651 WPF_DATAGRID_TEST X -
TR E AAXEE TS -
Status | Nawe A | Sceenty
Bad0 poeo] CustomerlD CompanyName Contact ContactTitle
ALFK Alfreds Futtericste Maria Anders Sales Rapresentat *
ANATR Ana Tryjiio Emparedados y helados | Ana Trujillo Owner 2
ANTON _ |Antonio Moreno Taqueria Antonio Moreno | Owner
AROUT Around the Hom Thomas Hardy | Sales Representat
SERGS Berghunds snabbicop Cheisting Berghund | Order Administrat
BLAUS Biauer See Deliatessen Fanna Moos Sales Representat
BLONP Biondel pére et fils Frécénque Cteaux | Marketing Manag
80LD Blido Comidas preparadas Martin Sommer | Owner
BONAP _ [Bon spp Lawrence Lebihan | Onner
BOTTM Bottonm-Dollar Markets Elizadeth Lincoln | Accounting Mana
BSBEV Victoria Ashworth | Sales Representat
CACTU Patricio Simpson_| Sales Agent
CENTC omercial Moctezuma Francisco Chang _| Marketing Mansg
CHOPS Chop-suey Chinese Yana Wara Owner X
‘ )
« i
1total /1 fitered / 1 selected -
[« 0 '

8. Start zenon Runtime in order to also test the control there.
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A Attention

Assemblies are only removed after loading when the application is ended. This means:

If a WPF file with a referenced assembly in zenon is displayed, then this assembly is
loaded is in the memory until zenon is ended, even if the screen is closed again. If you
would like to remove an assembly from the Files/Other folder, the Editor must first
be restarted, so that the assembly is removed.

6.8 Error handling

ENTRIES IN LOG FILES

Entry Level Meaning

Xaml file found in %s Warning The name of the collective file and the name of the XAML file

with different name, contained therein do not correspond. To avoid internal conflicts, the

using default! file with the name of the collective file and the suffix .xaml is used.

no preview image Warning The collective file does not contain a valid preview graphic

found in %s (preview.png or [names of the XAML file].png). Thus no
preview can be displayed.

Xaml file in %s not Error The collective file does not contain an XAML file or several files with

found or not unique! the suffix .xaml. It cannot be used.

Could not remove old Warning There is an assembly that is to be replaced with a newer version, but

assembly %s cannot be deleted.

Could not copy new Error A new version is available for an assembly in the work folder, but it

assembly %s cannot be copied there. Possible reason: The old example is still
loaded, for example. The old version continues to be used, the new
version cannot be used,

file exception in %s Error A file error occurred when accessing a collective file.

Generic exception in Error A general error occurred when accessing a collective file.

%s
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